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Limited Warranty & Disclaimer

Applied Enginearing warrants the Audio Animator card against delects in material and workmanship for a period of &
years fram the date of onginal retall purchase. Applied Engineering also warrants that, under normal use, the
magnetic madia on which the included software is stored is free from dalects in materialz and workmanship for a
period of 30 days from the date of onginal purchase. Any misuse, abuse. ar non-4 authorized alteration,
modification andior repair ta the Applied Engineering product will void the warranty. This warranty will also ba void i
you use the /E praduct for any other purpose than As intended use. | you discover a delect, Applied Engineering
will, at its option, repair or replace only the Applied Engineering producl, pravided you return the product during tha
warranty period, transpanation prapaid, to Applied Enginearing.

Theretare, please include a copy of the
ariginal invoice or a small servica charge may ba applied. |f the product is to be sent 1o Applied Engineering by mail,
the purchaser will insure the package or assume full responsibility for loss or damage during shipping Priar 1o
raturning the product for warranty consideration, call Applied Engineering Technical Support for a Return Material
Autharization (FMA) number and shipping instructhons,

Evan lhaugh Apphied Enginearing has tested the software and reviewed the documentaticn, Applied Engineenng
makes no warranty of repraseniation, either exprass or implied, with respect 1o the manual or tha software; their
quality, performance, marchantability, or fiiness for & particular purposa. As a result, the software and manual are
sald "as is,” and you, the purchasar, are assuming tha entire risk as to their quality and parformance

In fo evant will Applied Enginearing be Wable lor loss or damages of any kind caused either directly or indirectly by the
usa or possession of its products, even it advised of the possibility of such damages. The Apolied Engineering
Warranty is fof the Agplied Engineering Product itselt, In particular, Applied Enginearing shall have no liability fer any
othar equipment used in conjunction with Appled Engineering products nor for programs of data stored in or used with
Applied Engineering products, including the costs of recovaring such equipment, programs, or data.

The warranty and ramedies set lorth above are exclusive and in lieu of all others, oral or wrillen, express af mplied
Mo Applied Enginearing dealer, agent, or employee is authorized to make any modilication, axtension, or additan 1o
this warranty

This manual and the software (computer programs) described herein are copynghted by Applied Engineasring with all
rights resarved. Under the copyright taws, this manual or the pragrams may not ba caped, in whole or in part, without
the writlen consent of Applied Engineering, axcepl in the normal use of the sollware or o make an archival copy
This exception does nol allow copies 1o be made for athers, whethar or nat sold, but all of the materials purchased
{with all archive copies) may be sold, loaned, or given 1o anather persan, Under the law, copying includes transiating
inta anather language or farmal You may use this soflware on any computer owned by you bul exlra copias cannal
be made for this purposse

Applied Engineering cannot guarantee that you will recelve notice of revisions to the software, documentation, or
products described in this manual. Be sure 10 check with your dealer or Appliad Enginearing for information on
possible updates. However, Applied Enginearing reserves the right to make any improvements to Applied
Engineering products without any raspansibilty toward upgrading praviously released products

Apple and Apple liGs are registered rademarks af Apple Computar, Inc

PraDOS and 35/05 are trademarks of Apple Computer, Inc

Applied Engineering 15 a registered wademark of Applied Enginearnng

Audio Animator, Senic Blasler and RamKeeper arte trademarks of Applied Enginearing.
Radio Shack s a registered trademark ol Tandy Carparation.

MasterTracks is a trademark of Passpon Design, Inc.

Music Writer and MID| Translator are trademarks of Pygraphics.

@Copyright 1989 Appled Enginearing 101689

Applied Engineering
P.Q. Box 5100
Carrolton, Texas 75011
Sales: (214) 241-6060 9 AM - 11 PM (CST) 7 days
Technical Support: (214) 241-6069 9 AM - 12:30 & 1:35 - 5 PM (CST) Monday - Friday
(Tha Technica! Support talephone lines cannot be accassed through the Sales department |




Federal Communications Commission
Radio Frequency Interference Statement

The equipment described in this manual generates and uses radio frequency
energy. Ifitis not installed and used properly (i.e. in strict accordance with these
instructions), it may cause interference to radio or television reception.

FCC L.D. Number: EYSQGAUDANIMATOR

This equipment has been type tested and found ro comply with the limits for a
class B computing device in accordance with the specifications in Subpart J of
Part 15 of the FCC Rules. These rules are designed to provide reasonable
protection against radio and elevision interference in residential installation.

However, there is no guarantee that interference will not occur in a particular
installation. [If this equipment does cause interference to radio or television
equipment off and on, the user 15 encouraged to try to correct the interference by
one or more of the following measures:

d  Reposition the receiver's antenna. Also make sure the
antenna wires are making good electrical contact.
J  Use a roof-mounted antenna rather than a “rabbit-ear”
antenna or an anienna mounted in the arric,
O Make sure that all electrical connections on the computer
are secure and any shiclded 1/0 cables that are required for
compliance are properly fastened.
3 Move the computer farther away from the receiver.
3 Plug the computer and receiver into separate electrical
circuits.
If necessary, the user should consult the dealer or an experienced mdip:'lclevision
technician for additional suggestions. The user may find the following booklet
prepared by the Federal Communications Commission helpful:

“How to ldentify and Solve Radio-TV Interference Problems™

This booklet is available from the U.S. Government Printing Office,
Washingion, D.C. 240402, Stock No. 004-000-00345-4.

Note: This equipment has been certified to comply with the limits for Class B
computing device, pursuant to Subpart J of Part 15 of FCC Rules. Only
peripherals (computer input/output devices, keyboards, terminals, printers, ele.)
certified 10 comply with the Class B limits may be attached to this computer.
Operation with non-certified peripherals is hkely to result in interference to radio
and TV reception.

Finally, any unauthorized changes or modifications not expressly approved by
the manufacturer could void the user’s authority 10 operate the equipment.
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INTRODU!
Welcome to the Sound

The Board

The Audio Anim:
digitizer and pla
thunders into a whole new dimension. You've seen the Gs

an audio
vour [1GS

ator is both a MITH system ¢
back system. Once instal

hics, now hear its dynamic rodr

incredible gr:

The board is easy to install. 1t will work in slots 1, 2, 6, or
I Ly I:'_lil !-,l‘. ,1|‘l| easily

The external connector box enables y

connect line inputs and speaker ourputs and cont

: levels

recording and playbar

The Software

Sequencer
Hook up vour MIDI device (keyboard, saxophone, drur
machine
then ma
often repeated segments, add tracks, mix trac
The AA Sequencer lets you record
tracks

ete.) set the wempo, urm on

€ YOour own kind of musi

Digitizer

Connect your CD player, phono,
one to the input connectors ;
rorite songs, 1V shows, or noises you ik

ner, @pe plaver, YR, or

microp
your
mouth, hands, nose, pets, el

s avith your

Attach a microphone to the |1|:. 1€5 conneclor and Your
phono, tape deck, radio, etc. o the * [n con
g with your favorite songs. The included Super Hi-
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Clor and

sing alon
Res soft
record and playb
provided in the control panel

HZe 1N mono or sLer

k rates as well as volume s

But wait! There's more.,
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files from Al's vast

el sever

of sounds. We've pu
o' sounds” and put th
modifications to these file
disk first t

Feel free
1

L

but make a ba
1al files in their
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will

The Manual

In order to use this manual and the AA effectively, you must
know something about MIDI, If you're new o the field, ke
a look at “Other Sources” in App. 1 for a references

Notes and warnings throughout the manual will b
better understand what you're dealing with. They
shown in the examples fi

ds

2
following

o Nate: This indicates a special note. Pay close

alfenbon to these entries

This indicates a warning. Be sure 10 read
2 s

Audio Animator is the full name of the product. In this
manual, we'll often call it AA for shon

Part 1, The Hardw describes the ¢
you need to use it, and takes you through the installa

the Audio Animator

Part II, Software Overview, [«
run through of whart the A
Part IT1, The Di
options. The chapte
easy reference

15 by giving you a quick
y Animator software can d

b of the Seque

in the same o

Part IV, The Sequencer 5 €
menu oplions,  Again, the chapters ar

the menus for easy reference

The Appendices tell vou how 10 copy the AA pre 0
your RAM, ROM, or hard disk, how 10 work around
problems you may encounter, what ads

and maore

rs vou mav need

The Glossary contains many of the terms used in the
manual with which you may not be familiar

The Index is the fastest way to find a particular 1opic's page
number

1al or

n
h by /E

raing tn

preciated |

Any comments or suggestions re
any other /& manual, will be greatly ag
and by other
comments or sugeestions to

s who use our products, Please address any

Applied Engineering
P.O. Box 5100
Carrollton, Texas 75011
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CHAPTER ONE
Getting Started

% Warning: Do not connect or detach
Animator box while the computer is on!

What You Need
To effectively use the Audio Animator, you need
] A TIGS or Retrofit Gs (//e with a Gs motherbo
with at least 512K expanded memaory (768K o

3 A pair of external speake
amplified will work., The Aud

sound w rually ¢

really get that thumping stereo sound, yo

slereo sp

rral sSpc

Audio Animator

1w controls. 1F y

If vou h Ve 3 SICTEO T
to the Audio An
volume with your tuner

You'll con ers or tuner to the PHONES

CONNeCTor on the the box. While you
» Out connector on |

to the PHONES co

| the volume from th

connect them

the baox, drtac

enables yvou 1o
Output Volume

MIDI devices (e.2. kevboards, drum machines,

etc.) to create, playback, and modify your own
tur

Note: You must have a MIDI device connected o
play back MIDI songs. MIDI songs will not

h the G5 or AA ‘-.i\\_'.||\|_"-.

Some adapters mav be required to alle
speakers 10 connect to the Audio Ani
jacks. (Appendix C details some of th

available at any Radio

A Phillip's screwdriver is
need to install the Audio Animutor

Audio Animator - The Hardware
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Optional
There are many options open 10 you with the Audio
Animator., Below are a few prospects:
O  Use a microphone to digitize your voice

d  Connect your stereo to playback digitized sounds
through the speakers and to digitize segments from
phono, tape, radio, or CD.

O Connect a YCR 1o digitize excerpts from your
favorite TV shows or video tapes

O  Much, much more

Where It Goes

We recommend installing the Audio Arumator into slot 2
You can also use it in slots 1, 6, or 7, It will also work in slot 5

but most G5 users access the 3.5" drive through this port

u'll put the Audio Animator into
it and your current use of

Decide which slot
according to how you want 1o usc
the slots..

Playback Only

If you want to use the card for stereo playback only, you can

put the card in slots 1-6 without changing the Slot setting to
“Your Card”. For example, you can insert the card inio slot 5,
leave the Slot setting set to “Smart Port” and still play back
sounds from games, and music software

Recording and Saving Changes

To record or save changes to a file using the Audio Animator
software, you should install the card inslot 1, 2, 6, or 7 and set
the Slots option of the Control Panel to "Your Card.” 1f the

Slots option is not set w “Your Card” the s » will give

1 £ imacor

L¥]

you the error message,

f. 1" because it cannot locate the Audio Animator card

O If you're not using slot 2, put the card in there and

leave the Slots option set to "Your Car

O  If you're not using slot & or 7, put the card in there

and leave the Slots option set to “Your Car

O  If you have an external modem connected to the GS
modem port, put it in slot 2 and toggle between the
Audio Anir
Panel's Slots option

tor and the modem with the Control

AA - The Hardware

3O  If you have an internal modem and a printer
connected to the GS' printer port, put it in slot 1 and
toggle between Audio Animator and the printer
with the Control Panel's Slots option

RamKeeper Users

You'll need to take your RamKeeper out of its slot during the
installation. Before beginning the installation, back up your
ROM disk and disconnect both the transformer and the
battery. You will not need to remove the Ramkeeper's
connector plate. The rest will be explained in Chaprer 2
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CHAPTER TWO

Installation

To install your Audio Animator, you'll need a small Phillip's

screwdriver. Onee you have one

1) TURN OFF THE AFPPLE'S
Never install or remove 4 ¢
an. However, you need to

plugged in throughout the installation w

DoOWwWer -\.|'|J|1|'. 1 dhischarge
vour body

follow the SLeps bretow

y POWER SWITCH.

ard while the computer is

e the co

&2

static electricity from

2) Remove the cover from the Apple. Press in the
two latches in the rear of the case with your

forefingers while using the heel of

the lid up and towards you

3) Touch the power ﬁlll]rll\' Lo remove

electricity from vour body

A static sho |\ can dam

.--'-r""‘J

Remove the IIGS cover

4) Remove the plastic plate covering the |
opening in the backplate closest to the sl

* the I|| L
and/or the chips on your comp J|l. r's motherDodr

yvour hand
Lo Pt

Do not sk

Touch the power supply case

you plan 1o instll Audio Animartor

5) Remove the AA from its anti-static bag. |lold

the card by its edges, like a

a1z ik



S e

6)

7)

N e

Attach the Connector Plate to the 15-pin
connector, Insert the hexagonal screws in the
center-most holes. Tighten the hex screws
completely, Partialy insert only one of the Phillip's
screws into the plate. Do not insert the other
Phillip’s screw

Hex Screws

J- Phillip’s Screw
(insart partially)

Attach Connector Plate

Attach the 15-pin connector 1o the backplate of
the computer. If the cable is connected to the card,
disconnect it before mounting.  Feed the cable from
the inside of the computer. Slide the Phillip's screw
that you have attached to the plate into the bottom
notch of one of the large back panel openings,
insernt the op screw and then tighten both screws
The plate should be firmly mounted to the opening.

Connect 15-pin Connector to Backplate

Important! You must connect the mounting plate
1w the back panel of the computer for proper
grounding,  If vou do not, Audio Animator cannot
function properly

AA - The Hardware

cee
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8)

9

Insert the AA into any slot 1, 2, 6 or 7 (slot 2
recommended). Your computer must be OFF!
Align the AA's edge connector with the Expansion
Slot then use the heel of one hand to push the card
down into the slot and seat it firmly.

Insert card into slot

Attach the loose end of the 15 pin connector
coming from the backplane of the computer to
the 15-pin connector at the keyboard end of
the AA card.

Imporiant’ The red (ground) wire must be toward
the top of the card.

Attach 15-pin connector to card

Ch. 2 - Installation
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10) Now attach the loose end of the Ensoniq
Input/Output (E-1/0) cable to the seven-pin
aundio connector toward the kevboard end of
the motherboard directly above the power
light. The cable is keyed so that it will fir easily in
one direction only

Connect the E-I/O cable to the motherboard

10a) 1If yvou have a card in the Memory Expar

may need to remove it o plug in the E-1/0 cable, In

the case of RamRKecpers, be sure to back up your
ROM disk before unplugging the ransformer and
bPattery, You don't need 1o unscrew the
RamKeeper's connector plate; simply remove the
|-'.;il‘|'||{l'y|\1'|' from the ,"-En,"*,]{nlj. ]'\*!\
then plug in the cable. Don't reinstall the

RamBkeeper yel

15100 slot and

10b) 1f you've taken vour RamKeeper out of the slot,
reinsert it now. Make sure that the insulator is still in
posiiion before reconnecting the power. At the
end of the AA installation, follow the directions in
the RamKeeper manual for setting up the ROM disk

10c) The other end of the
connected to the sev

Make sure it is stll firmly connected

E-1/0 cable should be
1=-pin connector on the AA

11) Plug the 15-pin male connector coming from the
black box inta the 15-pin female connector you
have installed in the back
seCure connector

late. Tighten scrows 1o

The Hardware

Attach Box Cable to 15-pin connector

12) Replace the Apple's cover.

Amplitiar or
Tape Player

Phone, GO, Tunar
Tape Player, VCA, ol

Spaakers of W QT

Headphanes nIg—-—-..

THIHE

=5
Auiefies Animator Box

Microphone

MID TN MiDIDUT THARLU

Midi Devico

Typical Setup

13) Plug vour speakers or headphones, amplified
or non-amplified, to the phones connector.
The volume is contralled by the slide contrels an

the black box

Ch. 2 - Installation




14) If you want to send the sounds from your
card through a sterco amplifier or amplified
speakers, connect the line OUT (L/R) connectors
from the black box to the Line In (I/R) connectors
of the stereo. The volume is controlled by the
amplifiers themselves,

15) If you want to send the signals from a tape
recorder, CD player, turntable, tuner, etc o
the AA, connect the output of one of these to the
AA's Line In (L/R) connectors. To cor 1
than one of these devices, you'll need to us

16) If you have a microphone, plug it into the Mic
connector of the black box

17) To monitor the levels from the Line In or Mic
inputs, connect the speakers to the phones
connector and then use the Input Level, Output
Level, or Mic Level bars to adjust the volume

18) Attach your MID device such as a keyboard or
drum machine, by using the included 5-pin MIDI
cables to connect the MIDI Out fr e box to the
MIDI In of the device. Also connect MIDI In from
the box to MIDI Out of the dewt

i 5

19) Boot the computer and vse the Control Panel
to set the AA slot setting to “Your Card.” [
vou don't know how o u,'||_'='1_s_'_L the sering in the

vour Apple 1G58 Owner’s

20) Hardware installation is complete.

12 AA - The Hardware

CHAPTER THREE

The Box

Ourpuf Volume

he Volume bars let you control tf iplitude of speakers
or he lu|’l yones connected to the PHONES jack, The volume
Iso be affe Lru.l by the left and right volume bars on the
digitizer screen which control volume for speakers
connecte d to both the Line OQut and the Phones jacks. The
Left and Right velume bars will not have an affeet on any
speakers connected to the Line Out of the A& box

Input Level

put Level and MIC Level (below) allow for 4 broad range

Ir

nic level (low level input) to

Of INpUl Ssources
line level input (medium)

R frorm

put '-'-.'--'. adjusts the

bounce up about 374

—-.1:-.|n.1 |IL set so that the VU meter
of the way toward the top of their columns

MIDI devices are not affected by the input level setting

MIC Level

The MIC Leve
connected to the Audio Animator's Mic jack, As with
Input Level setting, the Mic Level should be set so that the V1]
meter bars bounce up about 3/4 of the way [\'-L\J.!'ki the top of

bar adjusts the input level from vour s '\.I e

their columns.

MIC Jack

Plug vour microph into this plug, Refer to the
appendices for ada

PHONES Jack
External speakers or headphones plug into the Phones jack
The AA Phones jack has a 1 Wart amplifier I| it will drive
headphones or unamplified speakers. The Output Volume
bars control the amplitude of devices « wted o the
PHONES connector.  Refer o the .Ii'|'ll_”'ll'ih't'.‘1 fear Ll||:l|'-ll Irs.

Ch, 3-The Box




MIDI IN Jack

Plug in the cable from the MIDI Qut port of your MIDI device
into the MID! In socket. This is the path that your device uses
to send the MIDI data 1o the computer

MasterTracks Jr. Users

In order for MasterTr: ize the Audio
Animator, you must copy and renamec the AA driver
(CARDSS30.MIDD to CARDGS0.MIDL The driver
located in the DRIVERS folder in the SYSTEM folde
(pathname “BOOTDISK"/SYSTEM/DRIVERS). You musl
then set the interface 1o “Internal card” from the "MIDI
Setup” option of the “Goodies” menu

are

MIDI OUT Jack

Plug in the cable from the MIDI In port of your MIDI device
into the MIDI Out socket, This allows you to pipe the music
out from the computer to the device

MIDI THRU Jack
The MIDI Thru jack allows vou 1o pass MIDI data throu
AA box to another MIDI device. The MIDI Thru jack is useful
only when you are using your 1GS as an instrument in a daisy
chain; you will not use it when yvour 1GS is the controller

OUT/IN - L/R Jacks

]

Warning! Do not use your original disks l

1) ‘opy the AA driver CARDES30.MIDM, to the
1S folder in the SYSTEM folder of yvour
MasterTracks boot ¢

from /MAA BOOTY/SYSTEM/DRIVERS
to MMTIIR BOOT/SYSTEM/DRIVERS

77 Rename the CARDAESI0LMIDI file 1o CARDOGES0.MIDI

§ . 3) Boot the MasterTracks program
Connect vour CD, phono, tuner, VCR, etc. to the Line In 1 .
OO . - i c ) i Choose MIDI Setup from the Goodies manu
connector o capture the sound from the device with AA's
digitizer or to monitor the sounds via speakers connected to 53 Choose Intermnal card under Pon

he Ph oc iark . . #
e | nones I"\I\ *:' ,"-.lu'.;' '\|Zh|l'l'| rac ks |I
T 33 be in the To ¥ 1
(pathne MTIR.BOOT"/SYSTEM/TOOLS)

Connect your stereo amplifier (Aux. Input) to AA's Line Out
connector to control the volume from your amplifier. You

can also conned a tpe playver © the Qut connector o save

your |||.Lf:|llr‘|':l creations o casselte

< Note: The left and right volume bars control the
volume of the Phones jack but will not control the
volume of the speakers connected to the Line Out
jacks. You will need 2 volume control knob on the
amplifier or amplified speakers 1o control the
volume of the Line Out jacks

What Now?

Experienced Users:

If you understand the funcuon of a sound card and know
last! When you want 1o
know more about a particular aspect of the card, use this
manual as a reference

whalt you want from yours, have a

Others:

Try out the Digitizer and Sequencer sessions in Part 1l and
then skim through the rest of the manual to check your
prons

=2 _Tha Br
14 AA - The Hardware Ch. 3-The Box
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Software Overview
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Ad - Software Overview

A

Audio Animator

fIIIRERERRL

INTRODUCTION

Start,

exXpenenc \'I,I mnci

Dl

dio Anir

makes the program's use extremely intuitive, IF vou've

Look, and Listen

ator's software has a Mac-like interface that

Finder or if vou've ever used a Macintosh

e, vou'll be familiar with many of the menu options and

how 1o use them

You should alres
"Click and Dr

the first three terms sound foreis

be comfortable with such

“Pull-Down Menus,” “Select,”
ave to wash my hair,” and

tabsles ™ ™

ML YOLUL, Y w'll need 1o

refer to “Using the Mouse” in the appendices

About the Audio Animator Disks

The startup disk contains the GS/0S5 files neces
pProgr
Sysier

.-'\|'-|l§1

v o run the
ir disk drives. The entire GE/OS

is not included. We recommend ths
rading o Lo/ O 1 your i

ym and access

fealer for up

already

and MIDI files we've created

tized sound

t with

second disk, Audio An, co

Running the Sofftware

Before vou run the software, do the following
1}

Use either System Utilities (included on your G8 System i

3

Make a copy of the Audio Animator disks

o Filer or yvour FEEvoriieé copy program o make
' PY proj

From here on, when we refer to the Audio

tor disks, we n the COPIES vou have just

madae

Copy the program to your hard disk, ROM
disk or RAM disk if vou plan o run

those locart

s, For instructions on
program to your ROM disk, RAM disk
see Appendix A

Format several disks under ProDOS so you'll
ha ce to save yvour work. (Audio A
does not support formating. )

AL
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Booting the Software

From the Startup Disk
1) Insert the Audio Animator startup disk into vour
boot drive.
2)  Turn on the computer,
3 The disk will automatically load the AA software
From the Finder
1) With the computer on and the Finder loaded, insert
your Audio Animator startup disk into a 3.5" drive
{unless the program is copied o your RAM, ROM, or
hard disk - see App. A).
2)  Double-click the disk icon to open its window
33 Double-click the icon AASYS16 1o run the
application.
Other Launchers
Follow the instructions for the launcher you use to run the
application AASYS10.

Keyboard Equivalents Note:

Next to different commands, you may see an open-apple

symbol followed by a lenter. This is the keyboard equivalent
for the command, The Cut (3-V) command can be selected

from the Edit menu or by pressing the open-apple key and
the V key simultaneously

Sample Digitizing Session
Following is a short example of how you can use the Audio
Animator to play back and edit digitized sound files.
To play a sound file

13 If you don't see the Digitizer Control Panel (see
following graphic), click and drag down the View
menu until the “Go to Digitizer” option 1§
highlighted and then release the mouse button. This
is called “selecting an option™.

Audic Animator - Software Overnview
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g:ﬂ g:f Record Somple Rote 12011 Hz
fus Ol N Moy Time: 0.0 | Seleet: 0
@ Single Ploy O Centinunus Ploy || Max Block: 866k | Resolutian: 01

4)

5)

6)

7)

8)

1)

The Digitizer Control Panel

&

Select the Open (-0 option from the File menu
This opens a catalog of your current online disk

If the Audio.Art disk is not the current disk
cataloged, make sure it is an accessible drive, and
then click on the “Disk™ button until 18 name
appears above the file list

Double-click on the DIGITIZED folder ty apen it
You can also open the folder by clicking once on the
folder to highlight it and then clicking on the Open
button,

Pouble-click on any sound file in the file list to open
that file

You can also open the lile by clicking once on the
filename to highlight it and then clicking on the
Open button.

The software will tell you that it is loading the file and
will display a bar showing you what proportion of
the file has been loaded and how much is left to load
When the file is loaded, you will see the sound graph
at the bottom of YOur momtor

The sound graph is a visual representation of vour
file's sound wave. The pathname of the sound file is
displayed at the top of the sound graph window
Click on the Play button {or press <option-1").

The sound file you have loaded will now play.

Repetitive Play, Volume and Rate

Click the Continuous Play button then press Play
(<option>-P} again,
The file will play over and over again

Intro. - Stort, Look, and Listen
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2)  While the file is playing, click and drag the “thumbs"
(white squares) under the Volume and Play
Sample Rate headings to vary the volume and speed

VATK

1

Note: You can also click on the blocks at either er
of the bars to change Volume, Playvback Sample
Rate, etc.

-

3 Click Stop (or press <option>-5) when you're ready
IO move on
Effects

13 Select a section of the file by clicking and dragging
within the graph

2)  Click and drag down the Effects menu

w (=) a s

3 Try out the different options; Cog
portion of a file then paste it back imo the file

several nmes | 1), select Backwards then click

Elay agdin, s ent section (by clicking and

another selection

dragging) and Ec
1 gel Of
keep E0ing, B-B-2-BC1 Cra-Cra-cra-crazy, evah some
fun, Tun, Fen, e,

keep go

4)  When you've jumbled up the selection beyond

king on the s

recognition, close it by either clic

box in the upper left corner of h window or

by selecting Close from the File window

<

Note: When yvou close a window vou'll be asked if

1 want o save changes to that file. Click No 1o
e in its onginal form. 1f you want 1o save

Cdve Uic fi
vour changes, select Save As from the File menu and

give yvour audio art a name

Sample Sequencing Session

Following is a short example of how you can use
Animator 10 play back and edit MIDI files,

1 MITI file, make sure your MIDI device is connected

ned on, then follow these steps

ave a MIDI
device connected; you cannot play MIDI files
directly from the computer

o Nate: MIDI files will not play unless

Audio Animator - Software Cverview
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1) If you don't see the Sequencer Control Panel
(below), click and drag down the View menu until
the "Go to Sequencer” option is highlighted and then
release the mouse button, As stated before, this is
called selecting an opton”

e il & |- 1]000:00:0

|> Heasure Bent | Elepsed Tine

Stop  Ploy Pouse  Record
Tempo: 106 bpm

&) [

The Sequencer Control Panel
2)  Select the Open option from the File menu
This opens a catalog of your current online disk

3) If the A

'l|n_t_;:

lio. Art disk is not the rrent

. make sure it is AN ACC |_"-'\|'1|:' || 1%¢ _i_,']l::

then click on the “Disk” button until its nar
appears above the file list

4)  Double-click on the MIDI folder to open it

You can a

so open the f 't by clicking once an the
folder to highlight it and then click
button

open that Hle

on the

51 Double click on ;

or file in the file list 1o

You can also open the file by clicking once on the
1wl then 141 1 not -
il dnd then chcking on the

filename to highlig
Dpen button

6)  When th see the editor
window at the bottom of your monitor

file is loaded YO W

The editor window contains a visual representition
of vour file's MIDI information. The pathname of
|||L' MID file is L|:'-!‘I|.|kl_'|| at the l:||| of the editor

window

) Click on the Play In

J n
The file you have loaded will now play
8)  Click on the Tempo scroll bar o speed up and slow

down the play rate.

9 Click on the different tracks PL (Play) coll
turn them on and off durin
no arrow = silenn)

playback (arr

Intra. - Start, Look. and Listen
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10) Click the LP (Loop) column of the different track 1o
have them repeat afier they've reached the last
measure.

11) Click Stop if vou're finished listening before the
song’s finished playing

Edit

1) Select a section of the file by clicking and dragging
over the dots within the editor window
The measures selected will have an inverse
background and squares from the rest of the graph

2)  Click and drag down the Edit menu

3)  Choose Copy (J-C) o copy the section to the
invisible clipboard

4)  Move to a different location in the piece by moving
the cursor to a different set of squares (measures)
and then choose Paste(T-P)

Keep copying and pasting the different parts. Don't
be afraid of ruining anything.

5}  When you've jumbled up the selection beyond
recognition, close it by either clicking on the small
box in the upper left corer of the graph window or
by selecting Close ((3-C) from the File window

< Note: When you dose a window you'll be asked if
you want to save changes to that file. Click No to
leave the file in its original form. If you want to save
your changes, select Save As from the File menu and
give your audio art 2 name

What's Next?

Use the rest of the manual as reference. Part I[] gives a
detailed description of the Digitizer screen.  All menu
options are described in the order in which they appear
starting with the File options and proceeding to the right

Part IV describes the Sequencer screen and then explains the
Sequencer options

The Appendices offer everything from instruction on how to
load the program to your RAM disk, ROM disk, or hard disk
1o some information abour adapters you may need and their
catalog numbers

Audio Animator - Software Cverview
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CHAPTER ONE

The Screen

| o% File Edic Wiew Effects Setup Sounds ]
- | T BE Left Volume
Stop  Plow  Pouse  FRegord (e Right Volume
I: 1 m

18355 Plowbock Somple Rate: 22611 Hz

——— @'l'“ul'l L1 | .
= O o [ FEserdSamsTe ke T T

Jul _mwN PlogTime: 0.8 | Select: ]
E}Sinn[l Ploy ) Continuous Play || Nex Block: 866k | Resolution: W1
a /REL/SOURDS/RSQURD |

-l

Digitizer Screen

%  Npte: ASOUND is not an included file

The Audio Animator screen presents you with a super-
simple interface and a wealth of information

The Sound Graph

The sound graph is the window at the bottom of the screen

It contains the sound wave of the file currently selected

The Select Bar

The select bar, the straight Aashing line within the sound
graph, lets vou choose paricular sections for playback and
editing

< You can play the entre file when the select bar is
flashing (nothing is selected) or by choosing Select
All (C1-A) from the Edit menu

=~ To play only a small portion of the file, click and

drag over the portion to select it and then click Play

Ch. 1 - The Screen &
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o

Select from the beginning of the graph 1o the
pointer position by holding down the command
() key while clicking the mouse.

[} Select from the pointer position to the visible end
of the graph by pressing <option> while clicking the
mouse

&  Extend your selection to the left or right withowt
changing your anchor point by pressing <shift>
while dragging the pointer 1o the left or right.

The Keyboard Help option under the Apple menu

presents you with a quick reminder of what the

mouse/keyboard commands are

%  Note: The Keyboard Help screens for the Digitizer
and Sequencer are different

Keyboard Help

Flaser Controls: Play  {option} P
Stop  (optiom} S
Pause {option} ¥
Recerd {option} R

These kews con be used along with mouse selection

Extend selection {shift keg)
Select toend (ogtion}
Select from begining  (command)

Digitizer Keyboard Help Dialog

Stop, Play, Pause, and Record

The Stop, Play, Pause, and Record buttons perform the same
functions as they do on a tape recorder. Click on the buttons
above the word to begin that function. The keyboard
alternatives for all four functions are given in the Keyboard
Help dialog. (See previous graphic.)

Stop, Play, and Pause affect the currently displayed sound file
Record opens a new file called, Untitleds (where # is a
sequential number) into which it places the sounds you input

Before recording:

1) Go to the Setup menu to set your Record Channel
option for mono or stereo record

Audio Animator - The Digitizer
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2)  Set your record level using the VU meters or the
Oscilloscope screen (under the View menu) and the
Input Level and/or Mic Level bars

3y If you have several windows open, you may
close them (save if desired) to compress the
available memory and get a larger Max Block into
which you can record.

e

Note: While recording, the Gs will be completely
occupied with digitizing; all other functions (VLI
meters, mouse, eic.) are disabled

The Casselte Label
The number on the cassette label tells how many bytes the
file occupies in memory. When working with stereo Hiles,
the cassette label gives the combined bytes for both the left
channel and the right channel. The file, ASOUND, shawn at
the first of this chapter, is 18,855 bytes - about 19K

Single Play/Confinuous Play

If you want the se
Single Play button. 1If you want it to play in a continuous loop,
click the Continuous Play button

VU On/VU Off
The VU meter is a visual representation of the input levels
being sent from the device you have connected to the Audio
Animator's In connector or to the Mic jack. Turn it On or
Off by clicking the appropriate button. Use the VU meter in
conjunction with the Mic Level and Input Level bars to get
the best recording level

d portion to play only once, select the

Playback Sample Rate

The Playt
slow (in Herz) the file is played back. You can change this
setting even while in play mode.  If the sound file you load in
contains the information about the speed at which it was
originally recorded, the Playback Sample Rate will be set
accordingly. If the file contains only raw data, playback will
be set to the default setting of 22,200 Hz. You can then adjust
the rate until it sounds correct and save it in a format that will
remember the playback rate you have set; AE, AIFF, 2:1, or
2.67:1 formats all save the playback rate information,

sck Sample Rate bar lets you control how fast or

Ch. 1 - The Screen
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Record Sample Rate
Record Sample Rate bar allows you to set the Hz at which you
record. A higher Sample Rate means a higher quality
recording produced and a larger memory block used

voice recordings require lower sample rates (7.0

re higher

In general,
and up) while music (especially from CD's) req
sample rates (use the maximum, 37,000, 1o get the hi
fidelity)

Play Time
FI

ay Time shows how '.:-np” in seconds. the currently
f lime is directly affected by Playback

file is. Play

Max Block

Max Block shows the amount of contiguous (unf

silable 1o the pro

nount of memory av

memiaory

the menus. This is because the
':u_-;."r,_'_ loaded into RAM for faster access. The Max Block
nt
largest recording you can make

mber is important to know because this tells vou the

2,

4  Note: If the Max Block doesn't seem to be
ing

still

ing as you close files, it is because a hile that is

i is held at a cenain place in memory, 1If
memaory, clo {and if d

all windows and n begin yvour recording

yvou're tight or

Select
Select tells vou how many bytes vou curreéntly have selected

I r - e
In the example screen, the selected area is bytes

Ject Al

ave when set to Full

If vou've selected the entire window (by choosin
[Z-Al or by «
View), and the number on the cassene label is s
different from the number in the Select Region, d

this is due to rounding. If the number on the label is al

ping across the entire w

L warry;

wice the number of the Select Region, you're working with a

1alf of the entire f

stereo file; each channel is

Audio Animator - The Digitizer
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Resolution

C5 J.ili 1O IS 2 alio O :'.l 3 1d fSOUNG samples per screen
Resolution is a rat f how many sound sampl I scCr

pixel are being displayed. 1:1 means that every horizor
pixel in the sound graph represents one s |
Resolution will vary from file to file and chan
you use the Zoom In/Zoom Out options under the View
MEL.
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CHAPTER Two
The “File” Options

Click and hold on the File menu on the left side of the menu

bar. You'll be presented with the following options:

New (C-N)

The New command creates a sound graph at the bottom par
of the screen with the name Untitled# (where # is an
appended, sequential numbet). New graphs are a good
scratchpad on which to combine different sound files. The
new sound graph will have 626 bytes of silence when in
mono mode or 1252 bytes of silence in stereo mode
(Choose between mong or stereo with Record Channel
option under the Setup menu before opening a new
window, )

You'll almost always want to get rid of the silence by
choosing Select All ((3-A) before pasting in a section you
have copied or cut from another file

+  Note: The program automatically opens a new
empty window when you record

Open ((1-0)

The Open command allows you to load a prerecord
file stored on disk

| sound

%  Note: Because sound files are memory intensive.
they take longer to load than do text files. You will
find the load time greatly decreased by copying the
files to and loading them from a RAM or ROM disk

For more information on ROM disks, s
"RamKeef

er” in the glossary,

For more information on RAM disks, refer 1o vour
Apple Has User's Guide

Ch. 2 - Thie “File” Options
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Append...

The Append option will open a file and stick it beginning-to-
end with the currently open file automatically and scamlessly
“This option gives you the ability to load a single file as large as
your memory allows instead of limiting the size of the file o

the size of a single floppy disk

Use this option to quickly piece back together a file you have
stored to different disks or 1o stick together two different
files without having to: 1) open, 2) seleat all, 3) copy, 4)

1 pen, & '
change windows, and 3) paste.

The first file opened will determine the playback setting for
the appended files and whether the file will be stereo or
monao

S If you open a stereo file and then append a m
file to it, the mono file will be split into two ¢
fnot true stereo but split mono)

Tnneis

] It WO O
it, the two cf
combined ir

mono file and append a siereo file o
nnels of the stereo hle will be
o one mono channel

Close ((7-W)

Close a file with this command ‘or by clicking «
the upper left comer of the sound graph wind

1 the square i
et

If you have made changes to the file without saving them, a
dialog box will appear asking if you want to save changes to
this file before closing
O Click No to keep the file as it was when loaded or as

it was when it was last saved
O Click Yes 10 save the file in its current state

0O Click Cancel to stop the Close and return you 1o the
program with the file still loaded

Save (-5)

Lise the Save option 1o save changes you have made 1o a files,
If you have just created the file, you will be presented with
the Save As 1_1i:|_||=‘g box (see Save As below). 1f you made
changes to a file that already has a name, the file will be saved
under the same name

Audio Animator - The Digitizer

i

—— EE—

Eh
My
1]
h :
(]
-

% Note If you try 10 save changes to a locked file
you'll be told that the file is locked and asked if you
want to replace it with the new information anyway
If you answer Yes, the new file will replace the old
and the file will be locked again. 1If yvou select No, no
save will be made

Save As

Save As gives you a chance to name an untitled file or save an
already named file with a different name and/or under a
different format.

When this option is selected, you're shown a dialog box like
the one shown below

Currant Disk -—[ <= /RERON/SOUNDSS
551 free out of 3100K

[ DX7 SCLERLE

) D) DA7.T0HTIH

File List ————— £ DNCHRHTER

O EXPLOGION

D) GURSHATS

L D) SRMPLE.SE

Save Wove fs: l S ]
Name Box —[ EEARPLE SESETON I[ Concel )

lipen

@ BE Format O RIFF Farmat
File Farmats ——— 121 Compressed () 2671 Compressed
) Row Dato

Save As Dialog

Scroll through the disk catalog by moving the thumb in
the scrall bar or ]'n..' l'lllf'l-(ll'!}: on the up or down arrows

Disks online will be displayed in wrn as you click this box
The name of the currently selected disk is displayed at the
top of the catalog screen (AEROM/SOUNDS/ in the example
above), The amount available and totl amount are also
displayed (551 free out of 3199 in the example)

If the disk you want to save to is not currently online, eject a
disk, that is, if no other drive is available, and insert the
correct disk into the drive, The disk will be found as vou
circulate back through the online disks -

Ch. 2 - The “File” Options
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&  Note: If you discover that there is not enough room
on vour data disk to store the file, you can save to
another formatted disk or Cancel the Save and make
more room on the disk by using Delete from the
Edit menu to get rid of any unwanted files. If the file
is too large 1o fit on a single floppy, you'll need to
break it up into several files and save w0 multiple
disk. Refer to App. E for instructions,

New Folders can be created with the name that is in the tile
box when you click the New Folder option. 1f a file or folder
already has that name, a new folder will not be created. Once
the folder is created, you can double click on it 1o open,
name your sound sample, and then save it in the new folder.

Open folders or files by selecting them in the file list and
clicking this button or by double clicking on the folder or file
name in the file list

Close the folder currently open by clicking this option or by
clicking on the pathname located above the file list

Save the sound file by the name that is currently in the Save
Wave As box by clicking this bunton. The file will be saved 10
the directory currently selected in the format selected

%+ Note: As stated earlier, if you try 10 save changes 1o 4
lncked file you'll be told that the file is locked and
asked if you want to replace it with the new
information anyway. If you select Yes, the new file
will replace the old and the file will be locked again
If you select No, no save will be made

Cancel returns you to the edit mode

Formats Recognized

The Audio Animator software lets you play and save sound
files from and to many different formats. It uses its own
format (AE), Apple's standard sound file format (AIFF), Raw
Data format (straight binary form), and 2:1 and 2.67:1
compressed.

AE Format is Audio Animator's own filetype. This is the
default format for saving files. [t is also Sonic Blaster’s
standard format, You can load and play any digitized files
created on Sonic Blaster with AA or visa-versa, Save the file
you want to use as your startup sound in this format. (See
“The Introplay Program” in the appendices.}

AIFF Format is the Apple Standard format

Audio Animator - The Digitizer
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2:1 Compressed is a format which docs some squeezing o
save the same amount of information in half the space.

2.67:1 Compressed same as above but compacting even
more. The difference between 2:1 and 2.67:1 will be most

noticeable on very larpe files
o Nate: The greatest difference between a
compressed files and a non-compressed file is the
amount of space it takes to store the file. Another
difference is that the fidelity may be decreased by
the compression. The quality loss is very slight
especially in the case of voice recordings Try savi
a file in both the compressed forr -
disk space and quality with the orig

Raw Data is a mono file saved in straight binary format. This
means that information, such as the speed at which the file
was recorded, is not saved in this format. IF vou're saving a
file recorded in stereo as raw data, the two channels wil ‘be
combined into one channel and saved as 2 mono file. When
raw data files are loaded, the playback
setting of 22,200 He,

rate 15 set 1o the default

%  Note: If you plan to use a prog
accessory that plays back sound files, other than the
ones provided with the Audio Animator, you'll necd
to find out the program's or desk accessory's default
playback rate (if it does not let von set the plavback
rate) and record your sound files at that speed
before saving as Raw Dara, I

am or desk

Iry saving the same file in the different formarts and
them back and check the amount of memory used to
determine if you can tell a difference

Delete..,

Delete is extremely uscful for getting rid of files vou no longer
want in order to make room for new files, When you choose
1?0|:":_:::‘. you'll be presented with the Open dialog. However
the Open button is now the Delete button. Choose the .1-\5,.
that contains the file you want to delete. 1f the file is in a
folder, double-click on the folder to open it. Click on :.Iu- file
you want to delete and then click Delete. You'll be asked if
You want to delete the file you've selected (a safen -
precaution). Click Yes to delete or No (o return to the main
screen without deleting the file, -

Ch. 2 - The “File” Options
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<  Note 1If vou click on a folder and then click Delete,
the folder will simply be opened, not deleted. Files
can be deleted only one at a time.

Print (-P)
The Print option presents you with the stan
dialog box

rd 11GS Print

<  Note: Before selecting the Print option, you'll need
to select your printer from the Control Panel desk
accessory. Refer to the System 5.0 manual for
directions

ImageWriter/Printer vild / Ef‘éf—:p& mode for print
Quolity (O Better Text
@) Better Lolor
) Droft

Poge ronge:

[roas not apply

Sal page range 1o "All"

®nl Chaose this satting to
Select how many copies

y pathna
O from: | Te: I:I
you want io make Copies

resoluticn
Poper Fead (@) Automatic () Hanual
~

(@) (GE)

Dialog box for Print option

is mode for

Set to this mode for
tracior-leed paper

[Cteler

Audio Animator will print the sound graph, the file's title,

and the resolution factor

Page Setup
The Page Setup option, when selected, displays the standard

1Gs |'2L:I-{L' DEWIP |1|'.;|U:\_'. bax

Audio Animator - The Digitizer
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Imagedriter/Printer vid
Select size of paper Paper: (@1US Letter
you're using OUSLrsut
AN Letter

() Internotional Fonfold
Yertical Sizing: Printer Effects:

@ bormal []50% Reduetion Select to print 1/2 size
Salect "Condensed” for —H~() Condensed [ Mo Baps Between Does not apply
sharpes! printout Irlsatitins: Pages

Prints vertically

( Cancel I |

Prints harizontally —————m——7—7

Dialog box for Page Setup option
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CHAPTER THREE
The “Edit” Options

Undo (-2)

1o car tion. The U
will be followed by the ent option you've selected
for example, "Undo Paste’ ; IF Lind
option for the change you've made, the Undo command
be dimmed

10 Ex

Cut ((-X)

Afte
rer ion from the screen and
clipboard. You can then paste it (o anothe

same file or to a different file

- vou've selected a poruon if the fra

ove the selec

Audio Anim

The selection will remair

EEEEEEERRE

(8]
the sequencer, until something I o take its
place, or until you quit the p
Copy (-C)
Choosing Copy when a portion of the
copy the sclection to the clipboard w
1 the screen
CHPIAT

If a se : file is selecte hen yvou choose Paste, the
clipboard contents will n with the
contents of the ¢
< Note: When you paste segments into th I

will eventually lengthen beyvond the rig | h

sound graph window, Select Full View ( ) from

the View menu 1o sce the entire graph
If a selection was recorded at a di 3 VO
paste it into, the pasted selection will | e of
the file into which ye » it

¢ ] CA# | - A
Q0 Audio Animator - The Digitizer _ Ch. 3 Edit* Options 4
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<+ Notee Use the same record rate when recording files
that you want to mix

A Note about the Clipboard

The Audio Animator's clipboard is a local clipboard; it can
T You

be used only for the active Audio Animator pr
cannot have a digitized seg

ment and a sequenced segni

n
the clipboard at the same time nor can you paste a sequenced
segment 1nto the -;'.._IUII/.L'r or visa-versa, Onoe you switch
between the digitizer and sequencer or quit the program,
whatever you currently have pasted to the clipboard is lost

Clear (<Delete>)

LJse the Clear command just as you would use the <delere>
key. The selected segment is removed from the document
without replacing the clipboard contents

Select All (-A)

g the selection bar

ts end. If you notice

» effect as drag

5 beginning

lect All has the s:

1 the sound graplh

el after vou've used Select All (while the file is in F
View), this is because vou're working with a stereo file. The
cassette label shows the total bytes of the left and right
channels combined

Audio Animator - The Digitizer

t the Select Region shows only half the value of the cassene

IS S S SESESERERN R

The “View” Opfions

Go To Sequencer

Change from the Digitizer portion of the progr:
Sequencer portion by selecting the Go To Sequencer o

& Nolee When you switch from the Digitizer to the

Sequencer, any information in the clipboard will b
last
Zooming
In the Zoom modes, described below, you can magnity

portions of the sound pattern. In these enlarge ews, VOu
can select very small parts of the wave and use the edil
functions to fine-tune the file—cut out unwianted noise or
unwanted silence, find the exact location at which a sound
begins, piece together sounds without popping, el

As vou zoom, the caleulated number of samples per pixel
will be displayed next 1o Resolution on the

sCrecn

Zoom (3-M)
Use the Zoom option to magnify a selected portion of t
sound wave, The
window

selected segment will fill the sound graph

Zoom In (-+(plus))

Se t Zoom In to condense the view
The wave is condensed from the beginnir

Zoom Out (--(minus))
Zoom Out steps you back from the wave giving vou a wider
view

Full View (Ci-F)

Choaose Full View to display the file's entire wave on
screen

e

Ch, 4 - The "View" Options
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*  Note: When you paste segments into the graph, it
will eventually lengthen beyoned the
sound graph window. Use Full View to see the
entire graph

* right edge of the

Oscilloscope
Choose Oscilloscope to set vour input levels before
recording. The Oscilloscope gives you real-time feedback in
response [ your input the Input | evel bar or the MIC
Lewvel bar on the box to change your record _-LL-! You can

also reset your 0 point to adjust L'r\ﬁ'|r|||n rcard. With
ne input to the card, the zero level should be I.n I. straight
across the middle line on the oscilloscope grid

| |

HIIIMEHINIIHTIWIIH-TIIH' I1IIIIH IIl!liIIIIIII
LA 0 SR A Iﬂliﬂlliillllll I

AT

0O N T SR
WL mmmﬁmmﬂmm (e

waw e |

I
@ Left Choanel m [ ]

(2 Right Channel Zero Rdjust

The Oscilloscope Option

d  Left Channel to see the input to the Left Channel

4 Right Channel to see the input to the Right Channel
0 = 10 freeze the wave momentarily.  Click Pause
in to continue real-time monitoring
J  and drag the Zero Adjust thumb to move the
horizontal zero line up I'|ph|1 or down (left). This
setting has no affect on the recorded sound

O oK when the record level is set to vour satisfaction

Change Color

%  Note: Colors set with the Change Color option will
be active for both the Sequencer and the Digitizer

Audio Animator - The Digitzer

Select Change Color from the menu and you'll be presented
with a color palete. Click on any of the four squares o
change that color. Adjust the color using the Red Green and
Blue slide bars

Red Component

I I
Green Component

| I R -

Blue Componeat -

I jm |
1H!Fuu]ttn1nr1nhlel EEuncell | |

The Change Color option

Click on the box
whose color you
want o change

Click

Q Dpefault Color Table to return o the default
Audio Amumator colors

a Cancel 0O return o the colors scl bwefore chos M

the Change Color option
[N oK when yvou've found a color scheme you like
The next time you start the program, the colors will be the
same as when you last quil the program
&  Notee Your color settings are saved o the

AAPARAMS file. Refer to App. A for a list of the
other settings stored in the AAPARAMS hile

Ch. 4 - The “View” Options
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The “Effects” Options

APTER FIVE

The Effects optons affect only the segment of the currently
active window that vou have selected

4  Nole: When working with stereo files, you car
select the channel on which you want the effects to
take place with the Effects Channel option in the
Setup Menu. You're given the options Display
Channel, and Both Channels. You can, for example,
echo the left channel while the right channel remains
unaffected

The Effects Channel option cannot be selected wi
working with a mono file. In mono files, all effects
will affect the single mono channel

Amplify...

First select the segment you want [0 am
option from the menu, A window will

to select the percent of amplification (2 is twice as loud)
%  Note: When vou increase the amplitude you also
increase the level of noise you have recorded
the ¢ 5t sound, make sure that your recordin
levels are set high enough to capture the sound

not high enough o cip the sound. See Distorted
Sound in the appendices, “Trouble Shooting

Backwards

The selected segment will be flip-flopped. This is your
chance to hear for yourself if there are any secret messages
backwards-masked into Rock-and-Roll songs. Play your own
voice backwards. Who knows? Maybe you, yourself
sending out messages so subtle you didn't even notice

Echo...

A window will appear

a ||:\\'|l_‘|)._', vou o set the Ech

iecation and the E

5 Options
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Fade Down
Fade Down will modify the selected segment to sound as if
the volume was gra Iy turned down toward the end of the
segment

Fade Up
Fade Up will modify the beginning of the segment to make
the amplitude build as if the vol | 1

| Echo Rmplificotion (3): 0
| = | 1]

Echo Interval (bytes): Eoon
| B s I

[ k0 [ Coencel )

1€ WaS g

Echo dialog box Silence

a Echo lon determines how loud the

g it with the sound of
echo wil

Silence replaces the selected segme
nothing: a sound like you've never heard be

> 5084, the default set setting for

1e volume of

most echoes. Each echo is at
the previous

> A Sett

1 of 100, will e

strength.

bove 100 will make it sc
i

echo is coming toward you, I ect

loud enough, the sound will be ¢l

[ings 4

-

i | Echo Interval determines how much of the selected
segment will acually be echoed.  Echoes are usually

referred 1o in time intervals

e A 1/8 second echo is about equal 1o the

1 @ bathroom

resonance

= A 1/4 second echo is like the echo in a large
hallway
™ A 1/2 second echo is like the reverberation in a

big auditorium

A 1 second echo is like y

lling in a cany

|I\||1|'
current plavback by 8, 4, 2, or 1 and then set E

Decide how you want your echo to sound, «

number

A couple of things 1o keep in mind

nurmb
cted segment, nothing will

erval to 3

> I you set the echo i

than the sel
happen

2 On the longer e
some silence to the end of the |
echo fade "natuarally” instead of stopping
abruptly

oes, You m

48 Audio Animator - The Digitize
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CHAPTER S
The “Setup” Options

Playback Channel...

You can choose o |'1!.1‘_-';'\:I|'}i :.l'l_'l}I_'_é‘_: 1e Left Channel, the
ht Channel, or Both Channels. Cancel leaves the settings
hey were before you choose the option,

Record Channel...

The Record Channel option lets you se
want Lo record

ot which channel vou

O  If you have a mono input device and set the R
Channel to Both Channels, you'll be recording
sound on one channel and silence on one channel

€ Nofe: Most mono inputs feed to channe

VU meter will show which channel is g
input

Q  If you have a microphone inputing to the lefi
hannel and have the Record Channel set to the right

L |
channel, you'll be recording silence

J  Sounds recorded on only one channel {monao) car
be played back through both channels by settis
Playback Channel to Both Channels

Effects Channel...

To activate this opt

', you must be workir
recording. Use the Effects Channel opu

o dictate whether
the Effects you select will affect both channels or just the

channel currently displayed. Using this option, you can, for
example, play a segment from one channel backwards while
leaving the same segment on the other channel the same

Default Play Rate

This option will set the Playback Sample Rate back to what it
wis when loaded. Raw Data and AIFF format files will be set
to 22 200 Hz. All other format files will be set to the Playback
Sample Rate at which they were last saved

Sef Play fo Record Rate

This is the easy way 1o set your Playback Sample Rate to the
same setting as your Record Sample Rate

Ch. & - The "Setup” Options




Set Record To Play Rate

€45y way 1o set your Reece

This s the 10 the CHAPTER SEVEN
same setting as your Playback Samy | i S
to match the playback speed of one file to the recording
e, you may

EEf

The “Sounds” Options

speed of the next sample you record. For exan

have a file that was rec rded a ven To make your

h the fast rate, select Set Record To

next recorded file ma
Play Rate and then record your new file. The new recordi
will be made rently set Record Sample Rate so . Pick the file you want to display from this list of currently
new rate will ch the old rate. Now the two hiles can be open files. You can have any combination of Digitizer and
together and won't sound like Mr. Bill meets Lurch Sequencer files open up to a maximum of eight
files are prefixed by "SMPL." The Sequencer files are |
by “MIDL" Change from the Digitizer 1o the Sequencer and
visa-versa, by choosing the appropriate file type from the
list.

List of Open Files

1t the o

edite

Display Dots

This option replaces the sounc

graph's lines with dots. It has

no other affect on the file

%  Note While the program allows a maximum of ¢
files open at the same time, your computer's
memory and the size of the files may mandarte a
smaller maximum

Display Left Channel

Shows the sound graph for the left channel of the current file

Display Right Channel

Shows the sound graph for the 1

1 % : o Tl
file. This option will be disabled
%  Note: Unlike the Effects option

to one channel's g

capy, paste, etc.) mad
also be made to the other channel's graph

AA - The Digitzer Ch. 7 - The "Sound” Options 53
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CHAPTER ONE

The Screen

& File Edit View Setup Sounds

|

Stop  Ploy  Pouse  Record

M
[ @]

I _11000:00:0

Measwre Beat | Elopsed Time

a] JREL/SONGS/RTUNE

TRIPLIREILP] CH | P& [Home i § 0§ 11 16 1 W |

bl | 10 [Helody EEEEODEEENENEEEOENNEENENDE

b ] fgss ~ |mODESDEONEEENESEEDDN 11

b ] fhythw | WSOSSONESOSONENOENES L]
110l

The Sequencer Screen

o Note: BATUNE is not an included file

Like the Digitzer screen, the Sequencer screen 1s both easy

o use and full of informauon

Stop, Play, Pause, and Record

The Stop, Elay, Fause, and Record buttons perform the
same functions as they do on a tape recorder. Click on the
burtons above the word 1o begin that function. The

keyboard alternatives for all four functions are given in the

Keyboard Help
picture following)

dialog box under the Apple menu (see

Ch | - The Screen
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Keyboard Help

Plog
Step
Pouse
Record

Plaower Controls:

Hetronome
Key In
Ruto Return
Count In

Button Controls:

(option) P
(option} 5
(aption) W
(optien) R

{optien} M
{eption} K
{aption) A
(eptiond C

Sequencer Keyboard Help Dialog

Record
Record lets vou enter new information
o the tra st 10 record

if a window i

new window and begins recording on

sure 10 begin the
clicking in the
The d

correct measure and beat

D Click in the RC column of the trac

arrowhead will

want 1o record,  An underlined

appear

1 Click in the PL column of any tra
|1|,I:\,' while vou record
3 leet the Time Signature by clic

halves of

rature, click on the uppe
nature box

desired time signature

the nme si

Jd AA will give vou a measure of co
beginning to record if you click ¢
or press <optuon=-L

@  Click on the Key In box or press <of

AA will wait until a key is presse

form of MIDI information is sent |

device) to begin recording

58 AA - The Sequencer

Measure--Beat box and 1y

ature icon next to the tempo b

When viou s

10t open, the program automatically opg

TACK

recording by

erault 15

CKS That wo

ot
'r and
and ente

N
m the

from the

k to which

1 "l\ _'--lll
until some
ym the MITI

MITI device

CEEEEEEEEEEEEEE

Play

<>

]

Play begins playing the track or tracks that have ar

Note- If you have Count In and Key In both selected,
AA will wait until you press a key, give you a full
measure of count and then begin recording

If you want the metronome to keep the beat while
you're playing, click on its icon or press <oplion=-
M
vl

Adjust the tempo

1 Arros 1n

the PL column, While playing a track or tracks, you still have

control over most of the sereen oplions —
stop the metronome, toggle tracks on and of

vou can start or

T

by clicking in

the PL column, change the tempo, select menu options, ¢l

&

Tempo

Control the Tempo with the tempo shd

Note: If you click and hold on the tempo bar or
menu bar, the MID informs: will not be
steadily to the MIDI device, €n you 1 &
mouse button the MIDI info. will be sent out ve
quickly in an attempt to “catch up.”

e bar

faster tempo (up o 400 beats per minute), left for slower
(down to 6 beats per minute)

3
4

J

Drag the thumb for larger incremental changes

Click in the shaded part of the bar to scroll the

tempo numbers
Click on the left and right ends of the bars to change
the tempo in increments of one

Time Signature

The time signature shows you the current beats per measure
Click on the time signature icon for the time signature dialog
box, To set the new time signature, click on the upper or
lower number and then enter the new number from the

computer's keyb
time signature into affect or click Cancel to leave t
signature as it was

ard. Click the Ok button 1o put the new
the tome

The time signat affects the entire picce

Incremental Forward and Rewind Arrows

Click on the forward and rewind arrows below the tempo

bar to move the play position in increments of 1 n
(triple arrows) or 1 beat (double arrows)

dSUre

Notice the change

in the Measure--Beal counters.

Ch. 1 - The Screen
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Count In

Selecting the Count In option tells AA to give you a full
measure of count before beginning the record or playback
Click on the Count In box or press <option>-C o
select/deselect the option,

Auto

Select Auto by clicking on the Auto box or by pressing
<option>-A. When the Auto option is selected, AA will
return to the point that play was last begun. Reset the
beginning play point with the rewind/fast forward butons,
the Measure--Beat settings, or the Elapsed Time settings
(described following)

Key In
When you select Key In, either by clicking on the Key In box
or by pressing <option>-K, AA will wait for you 1o press a
key (or send some form of MIDI data from the device
connected) before beginning to record or play. If you also
have Count In selected, you'll be given a measure of count
after you press a key before recording or playing,

Measure--Beat

The Measure—Beat box displays the currently selected
measure and beat. To change the Measure and Bear settings,
do any one of the following:

O Click on the Measure or Beat box and enter in the
desired measure and beat numbers from the
computer keyboard

3  Click on the forward and rewind arrows below the
Tempo bar

d  Play or Record

Elapsed Time

Elapsed Time displays the time of the piece in seconds as it's
being recorded and played. The elapsed time for playback is
directly affected by the tempo

%  Note: This feature is useful for timing sequences for
video dubs.

AA - The Sequencer
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Panic Bufton

The PANIC button sends an “all notes off" command to the
MIDI device. Although the Stop command keeps track of

which notes are on and turns them off, some keyboards get
confused and leave a note or notes on.  Simply click on the

PANIC button to turn the notes off

&  Nofe: The all notes off command will take a few
seconds to complete,

You may need put a delay between the note off commands o

give your device time to respond.  Use the "Set MIDI Delay”
option under the Setup menu (o set the Panic Button Delay

Try a delay of 532 and adjust from there as needed. (See "Set
MIDI Delay” in the Setup chapter.)

Metronome
The Metronome icon gives you an audible and visual beat
(click) of the currently set tempo while recording. The
metronome volume can be controlled through the 11GS
Control Panel volume setting

To be able to use Copy and Paste effectivly, you must play in

rhythm,

Toggle the metronome on and off by clicking on the
metronome icon or by pressing <option=-M

The MIDI Editor Window
The MIDI Editor Window at the bottom of the screen is
where the MIDI data is placed (shown as squares) for
playback and modification. Each square represents a
measure. Measures with MIDI data are displayed as filled
squares. Blank squares are measures in which no data was
received, The Editor enables you to work with the piece

after you've entered it. To modify a segment, you must select

it from the Editor window, Once selected, you can use the
options under the Edit menu to Copy and Paste repeated
segments. If you missed a note in a track, you can record
measure on another track and then paste it into the piece at
the proper location

The Editor features are described following:

Title Bar

The Title Bar is at the top of the window. It contains the
pathname of the currently loaded file.

Ch. 1 - The Screen
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TR (Track)

The TR (Track) column numbers the tracks, 1-8.

Close Box

PL

The small square in the left corner of the Title Bar is the Close
Box. Clicking in this box performs the same function as
selecting Close from the File menu. If you have made any
changes to the currently open file, you'll be asked if you want
to save the changes. Choose Yes, No, or Cancel, If the file is
untitled, you'll be given a chance to name and save the file

(Play)

Control which tracks playback g in the Pl
column. An arrow will appear in the PL column of tf
selected tracks. You can playback all tracks, -ific
or no tracks while rvturdmg or |'h|l'\.||' For e ple, ye
can begin playing just the bass track, then, while stll playing,
add the drums, and melody by clicking in the PL column of
the desired track

RC (Record)

LP

Click in the RC (Record) column to select the tr
you'll record. You can record to only one trach
underlined arrow will appear in the RC column of the
which yvou'll record

track o

When you have a track set to record, you can select where
the track will begin recording either by setting the measure
in the Measure—-Beat box or by clicking in the desired
measure within t When you press record, any of
the tracks set to play wi || be played while vou record

(Loop)

Click in the LP (L
want 1o repeat )}

YOI

* return arrow will appear in the column

next to the tracks that will repeat

%+  Nofe: If you begin playing a tr
of the track set to repeat, the track will not be
repeated. You can copy blank measures to make

tracks end at the same place

The Sequencer
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CH (Channel)

fferent

You can receive and send MIDI info. on up to 16 di
channels. Each channel can be a different MID1 device. For
example, you can set up your keyboard as cf -
drum machine as channel 2, and your guitar as channe y 3

The AA software will record channel changes 1 4 1r:
However, if you set the CH (Channel) sett iny number
other than 0, all information played from that track will be
played back on the ¢ annel you select. Leaving the CH
setting to 0 will follow the recorded channel settings

%  Note If you made a channel change within a
segment, the nrufnml m'.'omn'mw \\'il' be maintained
if you mp-. tha ack. For
example, if you record ':"!um d:.m el 1 on track 1
and from channel 2 on track 2 a
information from track 1 to track 2, the pasted
informaton will sull play on channel 1 while the rest
of the info. in track 2 will play on channel 21t the
sefting is set to 0

To select channels 0-16, click in the CH (Channe
then click on either end of the
to the desired channel setting, (
the seting. Click the Cancel button to les
was

roll bar or drag the |
I

lick the Ok button to accept

PG (Program)

Programs are the stored sounds (“patches™) in a MIDI device
Program for keyboards can be different i ments, horns
bells, strings, etc. Programs for MIDI drums
songs. Refer to your particular MIDI device n
information

The PG (Program) column displays the currently se
program

To select programs 0-128, click in the PG column
click on either end of the scroll bar or drag the thumb o
desired setting. Click the Ok button to
Click the | button 10 leave the setti

1coept the setti

It Was

Some of the rules for using the PG seting are

O A0 in the column means that there is no sel
program; whatever you set the plavback instrument
to will be the program used

yanuals for more

e Screen
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QO  The CH setting must be set to a number other than 0
for the program setting to take affect

O  When you set the PR (Program) setting in the Editor,
the MIDI device will play back using thar program

3 You can change the value from 0 up to the standard
MIDI maximum of 128

3  Since programs vary from instrument to instrument,
you may need to reset the channel when playing
back on an instrument other than the one from
which the song was entered.

O  You may need to reset the program if vou're using a
keyboard that has a program cartridge

O  If you're playing back through one channel only, the
f B §
program setting from the last track set to play is
used. Other PG settings are ignored. (See illustration

below.)
O {REL/SONGS/ATUNE
TRIPLIRCILP| CH | PG |Wome 1 4 B 11 16 W N
|11 1 OENNEEENEDE
11 1 n
k] 1 111
| o ' ‘; Replaced by last played track s
3 0 i Replaces Track 1
L 0 1 Ionored
1 [ T
[] [

Which PG Setting Is Used

O The program information is not part of the MIDI
information that is recorded, That is, if vou change
programs in mid song while recording, the program
change will not be recorded

Name

Click in any of the boxes in the Name column 1o name the
track. You'll get the "Track name” dialog. Type in a name for
the track and click the Ok button (or press <return>). The
name will then appear in the name column, The name ¢an be
up to 26 characters -- letters, numbers, or svmbols

However, only the first 20 characters will be displaved in the
Name column.

The Name column is a good place for a brief description of
the track — the instrument, the program, the sound, etc. The
Name info. will be saved with the file,

AA - The Sequencer
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The Select Bar

The select bar, the straight flashing line within the editor, lets
you choose the part of the file with which you want to work.
Click and drag over a measure or measures, horizontally
and/or vertically. You can select any segment from a single
measure in a single rack to all measures in all tracks (see
Select All in the Edit menu). The selected measure(s) will be
highlighted (the inverse of the non-selected measures)

Once you've selected a segment, use Cut, Copy, Paste, or
Clear from the Edit menu. The Edit options are described in
The Edit Menu chapter. You cannot use the Cut, Copy, Paste,
or Clear options unless you have a measure or measures
selected.

Scroll Bar

You can view 26 measures at a ime within the edit window
To move to the measures beyond the right edge of the
screen, use the scroll bar below the edge of the editor
window. Only the measure display will scroll. The rest of the
Editor window stays in place

End Boxes

Shaded Area/

The Scroll Bar

“\ The Thumb

J  Drag the thumb to a relative position within the
scroll bar

Q  Click and hold in the shaded area of the bar to move
the thumb to the cursor

O  Click on the left and right end boxes of the bars o
move in very small increments

Activaling and Moving the Editor Window

To move the active Editor Window to any location on the
screen, click and drag the Title Bar, By stacking windows,
you can view tracks of different files simultaneously

Switch between open windows by clicking on any visible
part of an inactive window or by choosing the inactive
window from the Sounds menu

Play, Record, Pause, FF, etc. will affect only the active window

Ch. 1 - The Screen




0o

AB - The Sequencer

A

Audio Animator

CHAPTER TWwO

- The “File” Options
- T¢I
- Open (1-0)

lI' e QOper VT ¥ le T dlesd (]

tracks and AA is | [ | , I-:'.l' I . ::..;.! I: .- =
- Close (C-W)

[ I"‘-“. .:. :ll_' \'-Il. [ IS I 1T ¥ 1 ir

the upper left corner wirnciomn

Il.l\"-l |I|" {

dialog box I

this file bef

—I L It |‘- I‘~"' [L8] '\l'l'E" -:”!' [ :'.' 45 1T was ".".: (=i | 1aed Of as
- it was when it was last saver

1 | ve the file 11l 51

5| o stop the Clo M vou 1o 1
- | The “File" Op
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Save ((7-5)

Use i

s option 1o save changes vou have made to a file.

you have just created the file, you will be presented wit

Save As dialog box (see Save As below), 1f yo ache

to a file that already has a name, the file will be saved under

the same name

4 Note: If you try to save changes to a locked file,
yvou'll be told that the file is locked and
want to replace it with the new inforn
If you answer Yes, the new file will replace the ol
and the file will be locked again. If you select No, no
save will be made

sked if yvou
T AnNYWay

Save As...
Save As gives you 4 chance to name an untitled file save an
already named file with a different name. Use Save As (o save
maodified version of a file without de

eting the original

MIDM files are saved in the

Progr:

standard MIDI file format. Any G5
m that recognizes the standard MIDI format (e g
Master Tracks Jr., Master Tracks Pro, Music Writer w/ MIT)
Translator) will recognize the AA MIDI files

n s selected, you're shown a dialog box like
the one shown below

e e < AE1-50NGS:
Currant Disk —[ 8970 free out. of 32767K. 1
C3 UK i

[ Sove , }
|| Concel |

When this opt

Fila Lis1

i

Sve Sequence fs:

Name Box —£ [wTTTLED

Save as screen

Scroll through the File List by moving the thumb in the
scroll bar or by clicking on the up or down arrows

&a Audio Animator - The Sequencer
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(Al

1:SOMNGS in the ¢ ¢ { e
and total amount are also d | (R979
K in the ex -_"_;l:l,"
If the d ve t0 15 not currently onlir ot
disk if no vailable d insert the correct disl
into the drive. The disk will be found as vou ci e Fael
through the I ks
New Folders can be created with the - that is i the

MName Box when vou click the New Folder aption. [Fa file or

.i!'l'.ll!:\".:' that r a new ol e cregue
Once the folder is « can n il te
Name your s = and 1 the ney
folder .
f]pﬂ_"ﬂ folders by 1 the filk I iwwkineg
this button or by double clicking on them in tf ile list

Save the sound Gle by the ¢ Savi

afquence As: ny will b

saved Lo the rrently selected

L el Lle ve ch (3]
locke Vol locked and

Cancel returns vou to th

Delefe...

Dielete is ¢
Want {1 or
Delete, you'll
the Open button
that contains the |
folder, double-click l.':‘ the folder to open |

fles. When vou choose

Honwever

e Delete |

0se th

to delete and then click T

You' | he asked
delete the file you've selected (a safety precau

to delete or No to return to the main
the file

screen without deleting




% Note: If you click on a folder and then click Delete,
the folder will | ned, not deleted.  Files
can be deleted only one at a t
deleted with AA's delete command

ST

Fol
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CHAPTER THREE
The “Edit” Opftions

The Edit options of the sequencer are only available wi
ient selected in the edit window

have a segr

Undo (3-2)
After you've made a change to th
to cancel the most recent ymmand
will be followed by the most recent option you've sel
for example, Undo Paste or Undo Delete, IF Und
option for the change you've made, the Undo command will
be dimmed.

Cut ((-X)

fter you've sclected a portion of ¢
remove the selection from the screen
clipboard. You can then paste it to an
same file or to a different seq

cer file

The selection will remain in the clipboard until yvou swit
the Digitizer, until something else is pasted in to take its
place, or until you quit the program

Copy ((3-C)

Choosing Copy when a portion of the file is selected will

copy the selection to the clipboard withow the
selection from the screen
]
Paste (C-V)
Selecting Paste copies the current contents of the clipboard

into the file at the selection bar position

the

le is s¢

If a section of the
clipboard contents will repl;

selection will be deleted

Ch 1-The *
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A Note about the Clipboard

The Audio Ani
be used

Audio A

egment and a

for the acuve

fe 4 QIgilzed s
ard at the same time nor can you |
Ersd. LNCE

SCUET

nt into the di
between the digitizer a
whatever you currently h

ZCT O VIS

nd SCQUEnCer Or gu

e pasted to the

Clear (<Delete>)

Use the Clear command 15e the <deletes

iment without

key. The cont

replacing th

Select All (T-A)

Select All |

Ah - The Seguencer

CHAPTER FOUR
The “View” Options

Go To Digitizer
Select Go To Dhgitizer
section of Audio Animator. Any op
left as they are. De fing on available

1o switch (o

: stereo digitizing

sequencer fily

have a total of eight
same time. For example
sequencer files open simultaneously

MIDI Dump

Select the MIDI Dump 1 10 Oper Pumy
window which shows you the binary n sent | 1
your keyboard 1o your computer as you press keys and

chanpe channels

Time fuent CH  Date
M001462Y  Pitch Bend [ RH
00014658 Chonnel Pressure 00 OB

000146R1 Channel Pressure 00 00

M0014788  Piteh Bend U T
M0014B01  Pitch Bend UK
00014843 Pitch Bend monw
M0014Ba2 Hoke On 0 uF 08
O00LYBIE  Piteh Bend T

|
Pause |

ﬂk‘

<) Use Recard Filter

MIDI Dump Dialog

You cannot record while in tf

Dump window to sec tf re
communicating properly

looks like when yvou pre

I'he information displayed ing

took place; Even » listing
On, Note OF, Pit Wend, et the

information was received: and Data

infor

View




¢  Note: You may notice that the numbers continue 1o
scroll through the window afier you've finished
playing several notes. This is because the computer
is receiving the MIDI info. much faster than it can
display it. Once it is caught up, it stops scrolling

Click the Use Record Filter box to toggle the Record Filter
sertings on and off. When the box is X'ed, the settings vou
have selected in the Channel Record Filter and Event Record
Filter options of the Setup menu will be in affect

Click the Pause button once to freeze the currently displayed
information.  Click it again (o continue the display

Click the Ok button to close the window

Change Color

< Noter Colors set with the Change Color option will
be active for both the Sequencer and the Digitizer

Select Change Color from the menu and you'll be presented
with Click on any of the four sq
change that color. Adjust the color using the Red Green and
Blue slide bars.

s 1o

i color pale

Red Companent

| B E— = [
Green Component -
| O e (|
Blue Component - -

[Default Color Table | [Concel § [ 0k ]

Click on the box
whose color you
wanl to change

The Change Color option

Click:

J Dpefault Color Table to return to the default
Audio Animator colors

O cancel to return to the colors set before choosing
the Change Color option

d O when you've found a color scheme you like

The next ime you start the program, the colors will be the

same as when you last quit the program

%  Note: Your color settings are saved to the
AAPARAMS file. Refer to the App. A for a list of the
other sewings stored in the AAPARAMS file

74 AA - The Sequencer

EEERERE

CHAPTER FIVE
The “Sefup” Options

The Setup menu contains options that allow you to filter out
any of the 16 channels and several events, such as pitch bend
and modulation, for record or playback. Each
has its own dialog box with click boxes 1o toggle
on and off. The Setup
Delay” which allows y
low-end MIT devices tha
high speeds

nu also has the option,
1o slow down the MITN ou

v not be able to handle

Channel Record Filter

The Channel Record Filter allows you 1o choose w
channels vou want on and off. You can click on
boxes to control each channel or choose All Channels On or
All Channels Off 1o control all at once, (X'ed box = channel
on, clear box = channel off)

ndividual

Channel Record Filter

B E5 E
E2: B¢ EHEnw
B B BEu B
By =t En BEun

ol

[ 11 Channels 0ff | Concel |

The Channel Record Filter Dialog

Event Record Filter
When you clear any of the Event Record Filter options
(uncheck the box), that event will be ignored while
recording. Your MIDI instrument must have the feature -
Foot Controller, Breath Controller, etc. — before it can be
recognized or ignored. 1f your instrument is not equipped
with an event, Audio Animator will not care if the box is X'ed
or not. (See picture next page.)

Ch. 5 The ~“Setup” Options
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KIOI Event Record Filter

B Wotes B2 Hodulotien

G Polushonic Kew Pressure [ Breath Loatraller
B2 Progrom Change B3 oot Contraller

B Chonnel Pressurs G=IA11 Other Control lers

B Piteh Bend

g

The Event Record Filter Dialog

Channel Playback Filter

While the Channel Record Filver will ignore the input fron

any filtered channel during record, the Channel Play

Filter will let vou filter out channels durir

g plavback. Fo
example, if you recorded a synthesizer through Channel

um machine through channel 2, vou can tum off the

nachine by clicking in the 1 box and then clicking the
Ok buron

Chonnel Ployback Filter

B BE7 BEv =HEa
B B¢ Hu =Eu
H Hr Eu BEs
By B Hu Ei

Iﬂl.ltl‘.nnnels[hl ! 1] I
[CALL Chonnels 07 ) [ Cancel ]

The Channel Playback Filter Dialog

When you filter a channel (clear the box), the channe
information remains intact, it is simply ignored during
playback.

When working with the Channel Playback Filter keep in
mind that the CH setting of the editor takes precedence. For
example, if you set the CH setting for a track 1o 3, all the MIDI
info will be played out channel 3. If you have the channel |
and 2 filters on (not checked), the channel 1 and 2 info will
still be played through channel 3. I you have the CH setting
set 10 3 and then filter channel 3, you won't hear anything .
from that track

76 AA - The Sequencer

Event Playback Filter

I'he Event Plavback Filter will let yvou filter out events during
with pitch
Nese

plavback. ‘This means that vou can record a tra
pia)

bend and key pressure enabled and then e

options for playback

KIDI Event Plowbock Filter

B Hates = Madulation

B2 Palgphonic Key Pressure 52 Breoth Controller
[5<) Program Change B2 Foot Controller

= Chonne] Fressure =811 Bther Controllers
B Piteh Bend

o
BT Events Off

MIDI Event Playback Filter

When yvou filter any of the options, that event will be ignored
while l'l-,ﬂ. ing. If wour instrument is not l't:'._'||.|u'|f with an
event, Audio Animator will not care if the box s X'ed or not

Set MIDI Delay

The Set MIDI Delay option is for the low-end MIDI devices
that cannot handle MIDI information at extremely high rates

Set WIDI Deloy
132

Plag/Record Delay (us):
]

Panic Button Delag (us): m
|

[ o 8 [ taneel )

Set MIDI Delay Dialog

Play/Record Delay
If you find that you have to turn your MIDI deviee off and
back on before it will play a piece or that sume notes don't
seem to be recording, vou may need to set the Play/Record
Delay. (Try a setting of 76 or 152.)
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Panic Button Delay

The Panic button (described earlier) sends an all notes off
command. This command sends out a note off command for
each note in rapid sequence. You may need put a delay
between the note off commands to give your device time to
respond. (Try a setting of 532.)

I

CHAPTER SIX

The “Sounds” Options

List of Open Files
Pick the file you want to display from this list of currer
open files. You can have any combination of - Digitizer and
Sequencer files open up 10 a maximum of eight. The Digitizer
files are pr;lm d by “SMPL." The Sequencer files are prefixed
by “MIDL" Change from the Digitizer to the Sequencer and
visa-versa, by choosing the appropriate file type from the list
or by choosing Go To Digitizer/Sequencer from the View
menu.

&  Nofe: While the program allows a maximum ol eif
files open at the same tme, your comp
memaory and the size of the files may
smaller maximum

Ch. & - The "Sounds” {
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A PPENDICES

The following appendices are included for further reference
and reading enjoyment

-

Copying Audio Animator to RAM, ROM ar Hard Disk

-- Trouble Shooting

O ®

Adapters

The Introplay Program

m o

-- Saving Large Digitized Fles to Multiple Disks

Lr |
'
'

Try This!

G -- Using the Mouse
H -- File Format

I -- Other Sources

] -- Getlting Help
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APPENDIX

Copying Audio Animator to RAM, ROM
or Hard Disk

The System

If you want 10 run Audio Animator from your RAM, ROM or
hard disk, you must use the GS/0S system 5.0. The GS/OS
version we've included with the Audio Animator was the
latest at the time the card was packaged. However, the Audio
Animator disk does not contain all of the GS/0S files, just
those system files needed to run the program and access any
disk drives you may have connected. Check with your Apple
dealer for G5/0S upgrades and documentation

% Imporiant: You must have the AA driver,
CARDS&530.MIDI in your DRIVERS folder in the
SYSTEM folder (pathname /“BOOT DISK"/SYSTEM
/DRIVERS). You must also have Tool 32 and Tool 33
in the Tools folder in the SYSTEM folder (pathname
MBOOT.DISK"/SYSTEM/ TQOLS).

Where's the Program?

The Audio Animator program itself is contained in the
AR.SYS16 file. The AAPRRAMS file is created by the program
and adjusted each time you quit the program. AAPARAMS
keeps track of which part of the program (Digitizer or
Sequencer) you were in when you last quit and returns you to
that part when you restart. The other settings saved in the
AAPARAMS file are:

Digitizer settings

Color, Volume levels, VU On or Off, Record Sample Rate,
Single or Continuous Play, the Effects menu’s settings for
Amplification setting, Echo Amplification and Fcho Interval,
the Setup menu'’s settings for Playback Channel, Effects
Channel, and Record Channel

Sequencer settings

Color, the last tempo setting, and all Setup menu settings
(Filters and Set MIDI Delay).

82 App. A - Copying Audio Animator...
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Booting from the RAM Disk w/o Your Own System
Loaded

To boot the program from a RAM disk, you'll need to set up
a RAM disk of at least 500K. If you have enough memory, you
can create a RAM disk large enough to hold several sound files
as well as the program. (Refer to your 11Gs Owner's Guide for
direction on sizing the RAM disk.) However, keep in mind
that the more memory you use as RAM, the less the program
has to use to record and play sound files

Initialize the RAM disk first and then copy the entire AA
startup disk to your RAM disk

If copying with the Finder, do not drag the icon of the Audio
Animator disk onto the RAM disk icon. Instead
1) Open the AA disk icon first
2y Select All (35-A)
3)  Drag all the files to the RAM disk icon
This allows the computer to find the files it needs 10 boot
4  Nole: Because this is an aute-start program, when
you boot it from the RAM disk and Quit (-,
you'll just be returned to the program. You'll need

to eject the disk and reboot the compurter to run a
different program

From RAM, ROM, or Hard Disk w/ GS/OS Installed

If your RAM, ROM, or hard disk is already set up with G5/08,
simply copy the A& 5¥516 file from the Audio Animator disk
to the volume

< Important: You must have the AA driver,
CARDBS30.MIDI in your DRIVERS folder in the
SYSTEM folder (pathname /“BOOT.DISK"/SYSTEM
/DRIVERS). You must also have Tool 32 and Tool 33
in the Tools folder in the SYSTEM folder (pathname

/"BOOT.DISK"/SYSTEM/TOOLS).

If you want to keep the current settings intact (color, volume,
etc.), you'll need to also copy the AAPARAMS file from the
System directory of the Audio Animator program disk to
the System directory of your boot disk

You may also want to copy any digitized or MIDI files with
which you plan to work onto the RAM, ROM, or hard disk if
there is room.

App. A - Copying Audio Animator.
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APPENDIX B
Trouble Shoofing

Strange Behavior in General

Audio Anim:
ng properly, it's probably do to a loose connectic

tor doesn't seem to be playing or

reCord

somewhere

& Important! You must connect the mounting plate
to the back panel of the computer fo
grounding. If you do not, Audio Anin
function properly

T

0T canna

Check the cables' connections to the card, 1o the
motherboard and to the back panel. ¢ :' eck the card's
connection to the expansion slot

A quick and thorough visual inspection before
Fechnic I|H|||[lur|n|||mu you both time ||-|r uble

Reversed Speakers

f you notice thar tt
program, or other sound softw

“wrong” speaker (left instead of right or visa-versa), simply
switch the speakers or their plugs around. The Audio
Animator uses the Apple standard left (our channel 1) and
right {our channel 2) output assignment
however, have the channels reversed

¢ stereo sound from a gar

C 15 Comun

‘Check starlup device” message
If you're trying to boot the program from a RAM disk, yvou
must initialize the RAM disk before copying the program
disk's files onto it

"Unable fo load ProDOS" message
If you're trying to | boot the program from a ROM or RAM
disk, the system folder must be on the 1 level (the root
directory) of the ROM disk. If vou dr: i
program dl:-n to the ROM or RAM disk {using the Finder), al
the boot files will be in a folder of their own on the disk
You'll need to open this folder, use the Select ALl option,
and drag the folder's contents to the ROM or RAM disk You
can then throw away the empty folder out of which you have
moved the files .

ed the icon of the

App. B - Trouble Shooting

MIDI Problems
Songs from other MIDI recordings sound awful

Some songs are recorded using several keyboards, drum
machines, MIDI] saxes, etc. The instructions that may have
been a drum track on one machine will sound like pure n
on another. Also, what may have been the organ program on
one instrument may be the gong program on another, Try
tming off different tracks and setting the program values to
0.

15€

MIDI Song Won'l Play
You must have a MIDI device connected o play a MIDI song
MIDI files will not play out the computer speaker or AA's
speakers

Make sure the MIDI OUT of the AA box is connected (o the
MIDI IN of the MIDI device.

The MIDI file may have been set up to |1| iy out a diffe
channel than your device’s channe | se 2. Try se |l||'|1' al
channels to CH 1 with your MIDI device set up as CH 1

Loading a Song that is more than eight tracks
AA has a maximum of eight tracks. If the you are
has more than eight, you'll get a message explaining that AA
cannot load the seng. I possible, load the song into the
program in which it was created and mix the tracks toget
or save the tracks as different files,

Digitizer Problems

Distorted Sound
O Once again, is the AA's connector plate screwed
onto the back panel? Is the other end securely
connected to the card? If net, the Audio Animator
is not grounding properly

O  Is the E-1/O cable connected to both the Audio
Animator and the motherboard?

o

Check your speaker wires, Are all the connections
secure? Are bare wires from the left and right wires
or the power and ground touching?

Q  Are you clipping the sound? If the peaks of your
sound waves are flattened against the top and/or
bottom of the sound graph window (see picture
following), you're clipping. This results in distorted
sound. Tum down your record level.

App. B - Trouble Shoating
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An example of clipped sound

Playback Sample Rate plays much slower than recorded
If you have a TransWarp GS, you need to turn On the
AppleTalk/IRQ option from the TransWarp’s Configure
MEnLL.

Pasted segment plays slower/faster than main file

If you're pasting segments from one file to another, you need

to make sure the files were recorded at the same rate. To
record a new file ar the same rate as an existing file, use the
Set Record to Play Rate option in the Setup menu while the
existing file is active, then record the new file

Other sound progroms do not play AA file correcily
Use the Save As command to save the AA files as either Raw
Data or AIFF files. If the sound progr you're using doesn't

allow you to change the playback rate, set the Rec .|r.,1 Sample
Rate to the necessary setting before recording,

Sound file plays but no wave displayed
If you do not see the sound wave even th wpeh vou can hear

the sound, it may be because you recorded a mono inp
steren.  Try displaying the other channel (from the Setup
menu

You may also be zoomed in on a sm:
Choose Full View (3-F) from the \.n womenu

| portion of the file

Audio Animator's Error Messages

App, B

Cannot Set BRecord to Flayback
higher than the

The maximum Playba
maximum Record
h\_ set equs il to the playback rate. For example, if your

rd Se&

Sample

1 ample Rate is sel 1o 43382, the Re
Rate cannot m.m.f: that setting

Trouble Shooting

» Rate -|>[5.|_ rec cwr._l cannot always

’[[[[[[llllllll[

Could not initlialize MIDI Tools
This is also a GS/OS error message. You need to copy the AA
driver, CARDB530.MIDI to your DRIVERS folder in the
SYSTEM folder (pathname /MBOOT DISK"/SYSTEM
/DRIVERS) and Tool 32 and Tool 33 into the TOOLS file in the
SYSTEM folder (pathname /*BOOT.DISK” SYSTEM/TOOLS)
CARDS530.MIDI and Tools 32 and 33 can be found on the AA
program disk.

Could not load tools from boot diask 0046
This is actually a G5/0S error message. You need o copy the
TOOLS file in AA's SYSTEM folder to the SYSTEM folder of
your boot disk (pathname /~BOOT.DISK"/SYSTEM/TOOLS

Maximum number of windows opened
You'll get this message when you have eight windows open
and you try (o open ancther with the Open, New, or Record
commands. Close a few windows before proceeding

Maximom of 2 Channels Supported
This error message appears when you try to open an AIFF
channel that has been recorded with more than two
channels. You won't be able 1o open the file

Missing FORM/COMM/SSND chunk in AIFF file
This is a seldom, if ever, seen, error message that appears
when a sound file does not have some required informaton
You won't be able 1o open the file

Muat first select record/play track
These messages occur when you try to record or play without
specifying a track to record 1o or play from. Click in the Pl
or RC column of one of the wracks.

Must have a 64K block to record
Must have a 128K block to record

If Max Block
when you try 1o record in mono, If Ma lock shows less
than 128K, you'll get this message when you (ry to record in
steren. Even [hlll_lgh you close files 1o free up memaory, the
GS memory manager may not join the newly freed ]"In:lLL.'h of
memory logether. This is the same reason that the t
Block setting may show you have 110K free be I||r: yOou
record a 100K file and still show 90K free when you finish the
TL'IZ'(Il'd:iH:\.g, the memaory manager does some MeEmaory
resorting 1o put together and make available frapmented
pieces of memory

shows less than GiK, you'll get this message

App. B - Trouble Shooting




Only 8 Bit Samples Supported
AIFF supports more than 8 bit samples. Sound files created
on the Macintosh, for example, may be 16 bit samples. You
won't be able to open the file,

|;a-<
I

APPENDIX

Adapters

Playback speed is too fast
When this message appears, the file segment is too small 1o
be played at such a high speed. Slow down [5
Sample Rate or select a |.¢:|L,:~' segment of the file. tln[Lu 12
and exiting the Control Panel while playing can also cause this
error),

Speaker Connections

Connect your speakers or amplifier to either the line out lefi
and right phono plugs on back of the box or to the 1/4"
Phones F]lu!__\ on the op of the box, You'll be able to contral
the speaker volume from the box when you connect them to
the Phones plug. If you connect them 1o the '\h no plugs on
back, you'll need 1o control the volume from your amplifie
Or Glﬂfﬂr\ﬂr-‘-.

* Playk

Requires AE Audioc Animater Card
The program can't find the Audio Animator card MJI\:.' sure
the card is installed pr<1|‘lu|v and thart the slot containing the

" in the Slots option of the Cont ol

;':1::5_-;\ P Connecting to LINE OUT
If your Hpt_dk(_l' wires (or wires from your amj plifier) end
e 1/8" plugs, you'll need the Steren Playback Y-Ada
that adapts a 1/8" stereo mini [1|u|g_. o a /4" phone p
well as an adapter that has 1/4" phone ;.u'l-; o o phone
plugs (often called RCA plugs). (Radio Shack Cat. No. 274-
367-straight model and RS Cat. No. 42-2471.)

K ) (To emorwm
s B

Requires GS/0S Operating System
You'll need o boort from a disk containing G5/05 before you
can use the AA program

Window must be open to Append
Before you can use the Append command, you must open a
window with the Open, New, or Record command. The
Append option will be enabled when you have 4 window

From Speakers or

open Amplifier
Window must be open to Faste RS Cat. No. 274-367 RS Cat. No. 42-2471
Before you can use the Paste command, vou must open a Adapls1/8" Stereo Plug to Adapts 1/4" Stereo Plug to
e 1/4" Steren Jack two Phono Jacks

window with the Open, New, or Record command, The
e option will be enabled when you have a window
open.

ra
If your speaker wires end in stripped ends, you can get two
“Mini Phono Plug to Stripped Ends” and attach it 1o a
connector with two 1/8" mono plugs to 1/4" stereo jack, (2
cables--RS Cat. No. 42-2434 and 1 adapter—RS Cat. No. 274-
307.)

From Speaker or :’=] (ﬂ“

Amplifier Wires

Left and Right ~ ] (::D=

To AA OUT (L/R)

RS Cat. No. 42-2370,
42-2372, or 42-2372
(', &', and 12" lengths)
Phono Plug to
Stripped Ends

% App: B Troubie-Sheefing App, C - Adapters &




Connecting to PHONES

If your speaker wires (or wires from vour a
the 1/8" plugs (often called RCA plugs), you'll need the Stereo
Playback Y-Adapter. It adapts 1/8" stereo mini plug to the
Audio Animator's 1/4" Phones plug. (Radio Shack Cat. No

274-371-right angle model or 274-367-straight model.)

Mono Digitizing

If your VCR, TV, 1
input and output

iplifier) end in

ipe deck, etc, h
rd vou want to
use a “phono patch cord” (RS Cat
2352 - 6 fr.) for mono recording

e

either the left or right channel

From Speaker or
Amplifier Phono Plugs To AA PHONES
Left and Right

For Mono Digitizing

To Audio "OUT" af mq::] [:CD—- To AA IN (L/R)
WVCR, CD, TV, elc.

RS Cat. No. 274-308
Adapts Two Phono (RCA) Plugs 1o
1/4" Stereo Jack

RS Cat. No. 42-2444
Phono Patch Cord

If your speaker wires end in stripped ends, you can get two
'Mini Phono Plug to Stripped Ends” and amach it to a
connector with “owo 1/8" mono plugs o 1/4" stereo jack ™ (2
cables—RS Car No. 42-2434 and 1 _|LEJ.:+:L-:--E{,‘\ Car. No. 274

S07.)

Stereo Digitizing
If you want to re cord in stereo from your sterco TV, sterea
VCR, CD p
cables mentioned

ver, tuner, tape deck, eu

above for left and r

Recording Your Creations on Tape

After vou've created a digitized hle or 2 MIDI tune, you may

From Speaker Wires ar y save it or sselte Or v oy s
Left and Right To AA PHONES i s e e
| e prope n,lul]h,-u-._l\..:\ nnect t U L
:E =T = tape deck or VCR's Line In
If vou have a setup different from the ones mentioned 1

RS Cat. No. 42-2434 RS Cat. No, 274-307 i okl Tadic Shack ncrnas oF stereorelectical wilics
1/8" Mono Plug to Adapts two 1/8" Mono Plugs to eallagr g p i
' x HpS i gs person for the correct cables and adapters

Stripped Ends 1/4° Stereo Jack
If you have a setup different from the ones mentioned, talk o
your local Radio Shack person or stereo/elec
person for the correct cables and adapters

Microphones

Chances are, you've p
somewhere; mavbe f

trical supplies

1 a microphone [yir

an old tape rec
answering machine, or from your days in
that could have made it big if the right peo,
heard vou.  If you don't have a mike aro
very inexpensive one at Radio Shack or at r
and super markets

CD, VCR, TV, Turntable and Amplifier Connections
Use the Audio Animaror line inpul connectors, located on
the back side of the box, for recording (o the digitizer from
vour CD player, VCR, Turntable, ape dec

k, etc

The microphones don't need to be super high
voice recordin

Record your creations 1o yvour tape deck or VCR by

connecting o the output connectors bt the higher the quality input, the beter
the recording (up (o a point). Start out with a low-cost mike
(Try Radio Shack's Windscreen Dynamic Omni—RS Cat. No
33-2001.)

The line connectars require phono plugs. Many cables end in
phono plugs and will need no adapiers

If your mike cable en

adaptor

Ano. - Ad

%0 App. C - Adapters

CEEEEEEEERERI:Z



For mono input, a2 mike with a 1/8" mini stereo plug needs a
1/8" 10 1/4" jack adaptor,

Tove'Mona | RS> ToaaMC
Microphone Plug
RS Cal. No. 274-325

Adapl1s1/8” Plug to
1/4" Jack

APPENDIX D

The Introplay Program

The file Introplay, found in the ! om/System, Setup
folder (subdirectory) of the Audio -\I'I.IIIHHIF |1I’r:;.'l' n disk,
nund as the GS/OS startup
ind file but

will play the sound file Intrc
screen is displayed. We've included an Introso

you can easily create your own

For stereo input, either plug two mono mikes jnLu a left and
right mono adapter (two 1/8" moeno plugs to 1/4" stereo jack
adapter—RS Cat. No. 274-307—see below) or try a dual head
microphone (RS Cat. No. 33-1065).

To use the Introplay program when booung from RAM
ROM, hard disk, or any other boot disk, -.-.J])\ ntropl
and Introsound from the Syste ster :
subdirectory of the Audio Animator ;‘:mgr.‘:m LJ.-|-, to the

T -up subdirectory of your boot disk

To Mono Microphones ( S

Left and Right
( --r.-.-.-

RS Cat. No. 274-307
Adapis two 1/8" Mono Plugs to
1/4" Stereo Jack

System/

To AA MIC
If you're booting the program from your copy of the AA
program disk, Int roplay is already in place

To create your own intro sound, run the Audio Animator
program and save the file you want as your intro sound 1o the
System.Setup folder in the Sy 1 folder on your boor
disk. The file must be saved as an AE Formar file called
Introsound

%  Nolte: If you do not have the program setup
correcty, the computer will stll boot but no sound
file will be playved during the boot

If you're using the Startpic program o load a picture
during boot, the Introsound file will be played either
before or after Staripic depending upon which appears in
the boot disk's directory first. If you want the picture loaded
before the sound file is played, L'<||:w S5ta > 10 the boot
disk before you copy rosound (o the boot disk. You
may also use a disk utlity, like JnhLI 1o arrange the order

o2 App. C - Adapters
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APPENDIX E

Saving Large Digitized Files
to Multiple Disks

If you have a file that is larger than a single floppy disk, vou

can break it up into two or more files and save it to separate
disks. You can then load it back into the program using the
4 option under 1

1w File menu.

l'o break up a file into several files, follow these instructions:

1) Hold down the O key while clicking the mouse
within the sound g

iph of the file
This will select a portion of the file from the

beginning 1o the point where you click the arrow

2} Check the Select Region to see how much is
selected
3y Continue to hold down the C key while dragging

more 1o the left or right within the sound graph unuil
vou have selected a region the size you want to save
Release the mouse button and ©F key

) When you have the right size, Cut it (3-X)
This moves the selected segment to the clipboard
Don't use the Copy command 1o move the
sepment o the clipboard. You need 1o remove the
segment from the sound graph window

50 Opena New file (O-N).

If you're segmenting a stereo file, vour Rec

* +1 should be set 1o Stereo Record before

1 new file, Otherwise, the two channels will
be combined into one mono file

J|;‘.l\'."l

If you're segmenting a mono file, set the Reco

1 2 before

nnel ity Channel 1 or Ct

the new file. If you set the Rec

'] o Stereo Record, the mono file wi
nto both channels (not true ste

; n
pasted

re, just s

mono) and the size of the segment will be doubled
[4}] Select A11 (3 A
Paste (0-V) the sound segment into the sound

graph window.

App. E - Saving Large Digitized Files
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9)
10}
11)

The "silent wave” used to create the window will be
replaced with the clipboard contents.

Save ((3-8) the file to whatever disk you want. (Refer

to the Save instructions in Chapter 2 if you don't

know how to change volumes, €lc

End the file's name with the sequence number, for
example, Laughs.1 will be your first save, Laughs.2
your second, etc. This will help you keep track of
the files' order to make Appending easier

Clase the window you have just saved

Return to the window you are segmenting

Check the size of the remaining segment as
indicated on the cassete label

& Ifthe 5el Region is 100 large 10 save o
yvour other disk, repeat the steps above
=3 If the Select Region shows a size that can be

saved 1o disk, use the Save As command to
rename the file with the sequenual number (Ex
Laughs.2), This saves the extra steps of cutting,
opening a new window, selecting all, et

Segmenting is complete. You can now load the
entire file back into the program by
first file (Fi
sequence (F

=ning the

nding the other files in

le. 1) then Ag

ile.2, 6 File.3, ewc.)

App. E - Saving Large Digitized Fles
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APPENDIX F

Try This!
(Tips and Hints)

Record Sample Rate

When deciding at what rate to record a sample, keep in mind
that the higher the sampling rate, the higher the sound qualiry
but the more memory used. We recommend that you
experiment to find out how the quality differs with lower
sampling rates for both voice and music recording. Notice
that the sound quality of voice recordings don't improve
much above a record rate of about 7,000 Hz while music
sound quality drops dramatically when recorded at the lower
rates

In general, voice recordings require lower sample rates
(around 7,000} while music (especially from CD's) require
higher sample rates (we recommend the maximum, 37,000)

Also keep in mind that you need to use the same record rate
when pasting a sound into an existing file.

Stereo or Mono?
. When deciding whether to record a file in stereo or mono,

consider these paints

A Do you have a stereo signal?
If you have only a mono signal, there is no reason to
record in stereo; mono recordings can play back
through both speakers

32 If you want control of baoth left and right channel
outputs of a mono recording, you can
1) Record the input in mono
2)  Paste it 1o a blank stereo file
3)  Edit the left and right channel separately. (See

"Effect Channel" p.41.)
This allows you 1o record and play back at a higher
sampling rate than if you make the recording in
stereo. (See also, “Traveling Sound” p. 56.)
Fun Stuff

You've probably had a chance to mess around with the

Audio Animator software by the time you read this; we have,

100. Here are a few things we've tried at Applied

] App, F - Try This!

Back Talk

Record a word or phrase forward, listen to it backwards,
record yourself saying it backwards and then flip it How
close can you get to making it sound like an intelligible word
or phrase? One phrase that sounds clear when reversed is
“eem pleh" ("help me").

%  Note: Remember that you're working with the way
words sound (phonetics), not the way they look;
spelling a word backwards and reading it will usually
not sound intelligible when flipped around

Traveling Sound

|

If you've played the Left . Cen.Right file through stereo
speakers, you've noticed that the sound moves from the lefi
speaker to the middle and then to the right speaker (hence
the name Left.C sht). Look at the left and right
channel of the file. Notice that the left channel has the first
drum beat, the right channel has the third drum beat. and
both channels have the second drum beat

You can make even mono files “travel” in this manr
copying them into a stereo window, setting the £
Channel to Display Channel, then pasting in silence over
a section of the sound wave at the beginning of Channel One
and at the end of Channel 2. Using this technique you could
record a joke in mono, then have the left speaker ask the
question (ex: Why are 5 and 6 afraid of 77) and have the right
speaker answer (Because 7,8, 9 and 100

't by

o

Answering Machines

Are people complaining about how boring vour answ enng

machine messages are? Well, with an Audio Animator, some

stutter, and a little echo, even the most commonplace “I'm
sorry. We can't come to the phone right now,.." comes
alive!

some answering machines allow external inputs for leaving
messages. If yours does, it may be possible to connect the
AA directly to your machine, If not, place the machine near
the AA speakers, begin recording with your answering
machine and play the file you've created from Audio
Animator. '

App. F

Try This!
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More Phone Fun

"Hey, Dad--I'm in jail”

Imagine the surprise your parents will get when vou call them Uang H‘le MOUSE
from il (any ;?||||=_'|_' show will give You Some g
background noise). Imagine the look on your child's face
when he ts a call fre ally ¢
by name (fast playback rate}. Imagine how envious vour
friends will be when you call them from your new car phone
hway ambiance, honking horns, maybe even a crash)
We're not say t vou should try any of these; but just
magine!

Click - push and release the mouse buton once

Alvin and he a them

Double-Click - push and release the mouse button twice
Drag - hold down the mouse button while moving the

ITIOUSE,

Selecting from Menus - To select an option from a pull
down menu, follow these steps
1) Drag the cursor across the menu bar to pull

‘It's a floor wax and a dessert topping” | i
down the menus

Ever talk to obnoxious phone salespeople who only let yvou
say "Yes” or "No"? Now you can let Audio Animator do the

Drag the cursor down the open menu 1o
highlight the different options

talking for vou. Record a “Yes™ and “No” then select and

3} Release to select the highlighted option

wWoin a
ease, ell me more!” and an “I'm not interested” for
1o send chills up

the appropriate one. After you're used to this,

%+  Note If you decide that you don't want 1o select

variety AL slower playDack rates from the menu you've pulled down, drag the cursor
their spine v ask m you live on Elm Streel outside the menu box and let go
and your name is Fred
Twistin'
Tired of tangling your tongue with twisters? Let Audio

I 54yIng ¢

Animator say -.i'lk"|| .-.'.L“'l'i.'| HL"\.\'ITLI YOUrse L
twister once (ex: The slick sheik's sixth sick sheep) ar

it continuous play ar
toy boat, toy boat, 1oy

ease the playback r

il

w8 App. F - Try Thisl App. G - Using the Mouse &

{
|
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APPENDIX H

Programmers’ Reference

This chapter contains technical information for
programmers interested in programming the digitizing
portion of Audio Animator. It is not a programuning tutorial.
If you're not a programmer you should ignore this
information. Don't look at it. Don't even think about it. ‘The
card will run fine without knowing what's under the hood

Identify the Audio Animator

In order to identify the location of the card, all the following
conditions must be true. Be careful to first check for disk
ports and the presence of other sensitive slot cards before
accessing these locations
I $CON*16+380-8C0ON*16+$87 are shadowed 10
3CON*16+588-53C0On"16+58F
2 $CON*"16+384 = SCON"16+885
3 3CON*16+%86 = SCON*16+587
4. SCON"16+580 and #352F = 804
5. $COn*16+$81 and #528 = 528
Digitizer Communication
Part A/ 670 Hi Speed 8 Bit A/D Converter
Registers Left Channel  3$COn*16+584
Right Channel $COn*16+586
Conversion Time 10us

Method Store register, wait 10us, read value

AE Digitizer File Format

The AE File Format in AA's Digitizer software attaches an ID
header with the following information to the sound file

Files Binary Notes
1D 54145504D 'AEPM'’
ype 2 bytes
Channel 2 bytes

App. H - Programmers’ Reference

,llllllllll’llill

Length 4 bytes

Fregquency . Dvtes il

Following the header is Channel 1 (Left Channel) sampled

data

Notes About

Files  Binary Info. pyamnie File

1D 'AEPM’ |

Type 0 AE Farmat
Channel | 0 Mono Recording
Length | 10246 | 10,246 byte file
Freg 30368 Recorded at the Highest SB
Record Rate
10,246 8-bit
samples
St

In the case of stereo files, Channel 2 sampled data
immediately follows Channel 1 sampled data and does not
require a separate header

Refer to the Apple Standard Sound File Formai (SSNDD
documentation for complete AIFF format information

MIDI Communication
Part 8530 Senal Communications Controller
Registers: SCC channel B command register $COn*16+580
SCC channel A command register $COn*16+581
SCC channel B data register $C0On*16+%80
SCC channel A data register SCON"16+ 380
Method Refer to 8530 Data Manual.  Also see Apple
Tech Note #54 entitled “MIDI Drivers.”

% Note: For MIDI File Farmat, refer call or write 1o

The International MIDI Association
5316 W, 5Tth St

Los Angeles, CA 90056

(213) 649-6434

App. H - Programmers’ Reference



APPENDIX I

Other Sources Gefting Help

This manual is a user's guide for the Audio Animator card and
software; it 15 not intended to be a tutorial on MIDI. There
are several good sources for complete MIDI information
including the following

If vou have a technical question relating 1o your Sonic Blaster
card or any other Applied Engineering product that is nof
covered in the manual, please contact the dealer from whom
you purchased the product. If you are experiencing
difficulties with one particular program, contact the
p:ug:[;l:n'ﬁ author or |'JL'.|1|I

Your MIDI device user’'s manual

Hurtig, Brent, Synthesizers and Computers. Keyboard

ine li or el : In the event that the dealer or the publisher's support
Magazine library for electronic musicians, GPI Publications

cannot answer your question, call Applied

personne
Engineering Technical Support I'he support representatives
are experienced in the applications and uses of Applied
Engineering products, but in order 1o provide a quick and
effective answer to your guestion, they will need 10 know as
ire and software

Anderton, Craig, MIDI For Musicians. Music bales Corp.,
Chester, N.Y. 10918

DeFuria, Steve, and Scacciaferro, Joe, The MIDI
mentaiion Sook Third Earth Pub

much as possible about the hardw
specifically related to your question. Please provide the
technical support representative with the following
information

Casabona, Helen and Frederick, David, Using MIDL
Keyboard Magazine library for e

ectronic musicians, GPI

lications -
0 The Applied Engineering product related 1o your
Milano, Dominic, ed. Mind Over MIDI. Keyboard
library for electronic musicians, GPl Publicatons

question and its revision number

tion of

The original and current memory config
k

he card (if applicable)

) e model and revision of yvour computer

! What peripherals are being used and what cards are

in each slot

L=

The name, version, and revision level of the software
with which you are experiencing problems
0 The results of any test programs, diagnostics, or

troubleshooting done by vou, your dealer, or your

software publisher's support department
Applied Engineering
Technical Suppon
(214) 241-6069
9 AM 1o 12:30 PM & 1:35 PM 10 5 PMICST)
Monday Through Friday

(Please call only the number above for technical

Qur sales office canne nsfer calls to the support lin

2 App. | - Other Sources App. J - Getting Help 103
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Returning a Product

RMA Number , “Attention® Sheet, and Invoice
If your product needs to be returned, the technical support
representative will give you a Return Material Authorizatdon
(RMA) number,

Record the RMA number for your own records

Write the RMA number on your package label

0ooo

Fill out the Return Form on back of the vellow sheet
marked "Attention” A complete form will greatly
reduce the ume it takes to return your package

2 Atach a copy of your original invoice to the form

< Warning . If you don't include an invoice, products will
be treated as out of warranty products and will be returned to
you C.O.D. for the amount of the service charge

A completed form should look something like the one below

Invoi

i i B frroduct fer regm, Pl congls e
s o gnal e

[Ty —

am 4 —_— Mem e GO .l

App. J - Getting Help

Packing

If vou don't have the original packing material, wrap the
board in anti-static material (preferably the anti-static bag in
which the card was originally shipped;, however, aluminum
foil will work fine). Pack it in a sturdy box cushioned with
wadded papers (i.e. used compuler paper of newspaper).

¢  Warning: If your product is damaged due 1o
inadequate packing, your warranty will be void.

Include the return form and invoice
Send the package, shipping prepaid, to

RMA#__?

Applied Engineering
Technical Support

3210 Belt Line Road, Suite 154
Dallas TX 75234

You should insure your package. /E will not assume any
responsibility for inadequate packing or loss or damage
during shipping

When We Receive

Our service depariment will use your completed form in an
attempt to duplicate the problem

If it is determined that your product is defective duc 1o a
manufacturing defect, your card will be repaired or replaced
at /A£'s option.

Any misuse, abuse, or non-/E authorized alteration,
modification, and/or repair to the Applied Engineering
product will void the warranty, This warranty will also be
void if you use the /E product for any purpose other than its
intended use

Your product will be fully tested before it is shipped back to
you, transportation prepaid, via UPS regular delivery

Once your product is received by Technical Suppaort, it will
be processed and delivered 1o our shipping department as
quickly as possible.

App. J - Getting Help
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GLOSSARY

AE Format - Audio Animator defaults to the AE format for saving

files. Information about the file's record rate is saved along with the

binary information so that when the file is loaded back into the
program, it will be set 10 the same speed as it was recorded

AIFF - This is Apple's standard sound file format

Append - The Append option will open a file and auach it 1o the
end of the file that is currently open. Use s option o guickly
piece back together a file that you have stored to different disks or
to stick together two different files. The first file opened will
determine the playback setting for the appended files

Channel - This refers to one MIDI data path. MIDI standards allow
for 16 different MID1 channels. The AA sofrware allows vou to
receive information from and send information to the 16 different
channels. You can, for example, have a MIDI keyboard set up as
Channel 1, a drum machine as channel 2, and a MIDI guitar .
channel 3. Refer to your MIDI device's user manual for instructions
on assigning channels

15

Clipping - Clipping occurs when your input is too “hot.” ("hot”
meaning intense in a bad way, not "hot" as in “cool,” “hep,”
“happening"). Clipping is evidenced by wave forms that flatten out
at the top or bottom of the sound graph. Lower the input level or
record level to prevent clipping

Compressed Files - These are files that have been in a form
which reduces the amount of space required to store them, One
disadvantage to compressing files is that during the compacting, a
small amount of fidelity may be lost. This loss is negligible for the
most part. Try compressing some files and playing back the
compressed and non-compressed and listen for a difference

Daisy Chain - is refers to connecung several MIDI devices in
serial connection.  Use the MIDI Thru port for daisy chaining

Digitize - When you digitize something with the AA, you convert
data from electrical nl}[ll;ll.\ {analog) to numbers: 0's and 1's

HERTZ (Hz) - Henz is a unit of frequency equal to one cycle per
second

MIDI - This is an acronym for Musical Instrument Digital Interface
Fhe MIDI standard was created to allow properly equipped
Instruments 1o communicate.

Glossary
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MIDI Cables - These are the two 5-pin DIN connectors included
with your Audio Animator. Music shops will have additonal cables

in a variety of lengths.

MIDI Channel - See "Channel”

MIDI Filter - This is a device, often implemented via software, that
can remove unwanted MIDI messages like pitch bend and channel
pressure. The AA software allows you 1o filter either during record
or playback. Refer to the chapter, “The “Setup’ Options.’

MIDI In - The MIDI In connector is the 5-pin DIN jack into which
you plug the cable from your MID] device’s MIDI Out or MIDI Thru
jack. It is usually located on the back panel of the MIDI device

MIDI Out - The MIDI Out connector is the 5-pin DIN jack into
which you plug the cable from your MIDI device's MIDI In jack. It is
usually located on the back panel of the MIDI device

MIDI Thru - The MIDI Thru jack allows you to pass MIDI data
through the AA box to another MIDI device. The MIDI Thru jack is
useful only when you are using your 1IGS as an instrument in 4 daisy
chain; yﬂu' will not use it when your 1G5 is the controller

Mini Stereo Jack - The mini stereo jack is the connector used on
Bose Roommate speakers, Sony Walkman, and many other portable
stereo systems. This jack is becoming more popular because of its
compactness. It incorporates the left and right inputs into one
connector.

Oscilloscope - Audio Animator's oscilloscope lets you see a real-
time waveform of the input received from the device connected to
AA's input connector. You can't record from the oscilloscope
screen. Set your record level in the oscilloscope window (for both
channels if recording in stereo) and then click OK to return (o the
main screen where you can begin the recording

Pathname - A pathname is a path of directories required 1o access a
specific file on a disk device. To reference a file named MYDATA on
volume /MY .DISK you would use a *path” 1o the file

/MY DISK/MYDATA. Some files may be additional directories and
those directories may contain references 1o more files or more
directories, The main volume directory is called the “root
directory.” Directories within the root directory are called
subdirectories. If you want to refer to a file contained in a
subdirectory, you must include those intermediate subdirectory
names in your full pathname. Say you have a volume called STRE
and have a subdirectory called HOUSE and have a file called ROOM the
complete pathname 1o access the file ROOM would be
/STREET/HOUSE/ROOM. See: Prefix.

Glossary

a7




0]

Phong Plugs/Jacks - Phone plug (male connector) or jack
(female connector) is a single prong or single hole connector. The
difference berween the phong and phono connectors is that the
phono connectors have a circular metal extension around the plug
or hole

Phono Plugs/Jacks - The phono plug (male connector) or jack
(female connector), also called RCA plug/jack, is used by many
record players, tuners, etc. for connecting one to the other, It has a
single prong or hole with a circular metal extension around the plug
or hole

Pixels - These are the small rectangles used to form images on
your monitor. When using the Zoom functions in AA's digitizer
software, the resolution is expressed in pixels. The highest
magnification, 1:1, is one pixel per sample

Playback Rate - The rate in Hz (samples per second) at which the
file is played. You can change the Audio Animator's Playback
Sample Rate setting even while the file is being played. A higher
playback rate heightens the pitch and speed (think helium). A
lower playback rate lowers the pitch and speed (think horror films)

Prefix - The ProDOS prefix is a standard default partial pathname
that is added to any file name you specify if your pathname is not
fully qualified. A fully qualified pathname is one that starts with the
volume name followed by any subdirectories that must be accessed
to find the file in question. A prefix is used 1o shorten the amount of
typing you must do to specify a pathname to a file. As an example,
suppose you have a volume called NATIOR and that volume has a
subdirectory called STATE and you have a program file called ¢
that is in the STATE subdirectory. Withaut a prefix, you would have
to use /NATION/STATE/CITY as the pathname 1o your file. You
could, however, set the prefix to /NATION/STATE and then you
would only have o specify CITY as your pathname,
fHATION/STATE would be automatically attached 1o the fromt of the
pathname you specified.

Prefix Directory - The Prefix Directory is the directory specified
by the current ProDOS prefix; i.e., if the prefix is set as

/MY .DISK/GAMES then the Prefix Directory would be the
subdirectory called *GAMES" found in the /MY .DISK volume
directory

RamKeeper - RamKeeper an Applied Engineering board which
allows you to set up your 11GS memory card as an “electronic hard
disk.” This means you can load programs and data files at a super-
fast rate from RAM without having 1o insert and swap disks
Programs and data files can be retained in memory even after the
computer is shut off for instant access next time you power up,

Glossary

Raw Data - This is one of Audio Animator's Save As. .. formats,
In this form the file is saved as straight binary information
Information, such as the rate at which the file was recorded, will not
be saved. You may want to save files in this format to playback
through a desk accessory that plays sound files. For this purpose,
you may want to determine at what speed the DA plays the binary
files and record vour sound ar that rate,

RCA Jack - The RCA plug (male connector) or jack (female
connector), also called a phono plug/jack, this connector is used by
many record players, tuners, etc. for connecting one to the other

RESET - If you get yourself into a part of the program and can't
leave, then as a last resort you can usually use a @-HI’;\]E'I'

command. You execute this feature by holding down the and
RESET keys simultaneously, followed by releasing the RESET key

€ Warning: If you use this option while a program is
trying to write to disk, you may damage the data on
your disk

Sampling Rate - This is the speed at which the computer takes
information from the sounds that are being sent to it. A faster
sampling rate means higher quality because the computer is
recording more information in a given amount of time than it does
at a slower sampling rate, In general, use lower sampling rates for
voice (because there isn't a lot happening during a voice inpur) and
higher for music (because there's a lot going on),  Refer 10 “Record
Sample Rate” in Appendix F for suggested sampling rates

Touch Sensitive - MIDI devices that are wuch sensitive records
the amount of pressure used when keys or pads are struck. The
harder you strike a touch sensitive key, the louder the response

Tracks - Tracks are the separate storage places for MIDL
information. The AA software allows you to record into 8 different
channels. The 8 tracks can be independently recorded, played,
edited, looped, named, and each can be assigned a different channel
and program.

VU Meter - VU stands for Volume Units. The two meters on the
screen give you a visual representation of the input levels the Audio
Animator receives, Like the Oscilloscope, the VU meter 1s an
effective tool for setting the record level.

Waveform - In relation to the Audio Animator, a2 waveform is a
graphic representation made up of binary information derived from
samples in the digitized recording,

Glossary



PG (Program) 63

INDEX

2:1 Compressed 37

PL (Play) 62
Print 38

Raw Data 37
RC (Record) 62

2.67:1 Compressed 37
AE Format 36

AIFF Format 36 Save 34
Auto 60 Save As 35

CH (Channel) 63 rormats
(digitizer) 36

hange Color 74
Ct

Select all 42

innel Playback Filter 76
d )_'1

1
aEectng

innel Record Filter 75
selecting an opuon 20, 23

ipboard 42, 72
cl 3 set MIDI Delay 77
LAOSE !

- - Tempo 59
Copy 41, 71
( I £ time signature 59
sount In 60 ,
Cut 41 71 IR (Track) 62
LUl 41,

Undo 41, 71

Delete 37, 69 o
Flapzed Al video dubs 60
sapsed = (30

Joom 43

Event Playback Filter 77

Zoom In 43

Event Record Filter 75
Zoom Oul 43

forw and rewind arrows

50
Full View 43

GoTol

Key In 60

yoard alternatives 28

keyboard equivalents 20
Keyboard Help 28

LP (Loop) 62
Measure--Beat 60
Metronome 61

MIDI Dump 73

MIDI Editor Window 61
\ll s

Name &4
New Folder 36

Oscilloscope 44

|".L_L!l' Setu

Paste 41, 71

Index
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